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INTRODUCTION

HyperPaint for the Atari ST heralds the next generation of Graphics Packages
offering a versatile, all-purpose tool for creating, editing and printing all kinds of
pictures and diagrams.

HyperPaint encompasses the features provided by current Paint packages on the
ST while adding a variety of new, powerful commands that speed up and simplify
the whole process of creating high-quality images.

HyperPaint fully supports the Atari GDOS (Graphics Device Operating System),
giving the user access to a library of different typefaces and printer drivers that
can be shared by other applications.

HyperPaint supports a wide range of picture formats and provides an ideal
environment for editing and re-touching large scanned images suitable for use
with Desktop Publishing Software. Image sizes ranging from 32K NEOchrome
and DEGAS files to massive multi-megabyte scanned images can be handled with
equal ease.
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GETTING STARTED

GDOS INSTALLATION

HyperPaint requires that the Atari Graphics Device Operating System (GDOS) is
installed before the program is loaded. This installation procedure varies
depending on your hardware configuration.

512K ST COMPUTERS

Owners of 520ST, 520STM or 520STFM computers may find that they need to
limit the number of fonts and workstations used by HyperPaint. Installing
additional GDOS fonts will reduce the number of graphics workstations available
to the program. We have supplied a pre-configured GDOS installation suitable for
the 520ST on the HyperPaint program disk. To install this insert the HyperPaint
program disk into drive A and switch on the computer. GDOS will automatically
be installed. Then follow the loading instructions shown overleaf to run
HyperPaint.

SINGLE DRIVE SYSTEMS

Whilst HyperPaint is loading, GDOS requires access to any fonts and printer
drivers named in the system’s ASSIGN.SYS file. It may be impossible to fit both
the HyperPaint program files and all of the font and driver information onto a
single diskette. We therefore recommend that owners of single drive systems use
the pre-configured GDOS installation mentioned above.

TWIN DRIVE AND HARD DISK SYSTEMS

Systems containing either two floppy disk drives or a floppy and hard disk drive
should configure their system prior to running HyperPaint using the font and
driver installation program supplied on the GDOS distribution diskette. For full
GDOS installation instructions refer to Appendix A.




GETTING STARTED

SYSTEM REQUIREMENTS

To use HyperPaint, your system should include the following equipment:

* Atari ST or MEGA ST computer

* Atari floppy disk drive (two are recommended, either two floppy drives or
one floppy and one hard drive)

2 Atari monochrome or colour monitor or TV

* GDOS compatible printer (optional)

If you haven't already set up your ST or MEGA ST computer system now is the
time to do so. You'll find complete setup instructions in the Owner’s Manuals that
came with your system.

This manual assumes that you already know how to use your ST or MEGA ST
computer and that you have read your Owner’s Manual. You should know how to:

Open, copy and delete disks and files using the Desktop.

Point, select, drag, and double-click with the mouse.

Scroll in a GEM window using the scroll bars and the scroll arrows.
Manipulate the size and position of windows using the size box and
move bar.

Pull down menus and choose commands.

L I I ]

BACKING UP HYPERPAINT

You may make backup copies of HyperPaint, but not of the manual. Every copy
must include the same proprietary and copyright notices as the original. You may
not sell, loan, or give away a copy of HyperPaint.

Before you do anything else, it is essential that you make a backup copy of the
HyperPaint program diskette and the GDOS distribution diskette. A backup copy
protects you from losing the original disk or damaging its contents.

Move the write-protect tab on the original disk so that you can see through the
notch. Then copy the original disk from the GEM Desktop following instructions
given in your Atari ST or MEGA ST Computer Owner’s Manual. You can copy
the disk to a formatted floppy or hard disk.

Once you’ve made the copy, store the original in a safe place; always use the
backup copy as your HyperPaint master disk. Never make changes to the original
disk.




GETTING STARTED

HYPERPAINT FILE INFORMATION

With the GEM Desktop displayed on the screen, insert your backup HyperPaint
master disk into your drive, then obtain a directory window of the disk. You’ll
find the following files on the HyperPaint disk:

AUTO FOLDER

GDOS.SYS FOLDER

ASSIGN.SYS
DEFAULT.BRS
DEFAULT.CFL
DEFAULT.MFL
PAINT.DAT
PAINT.OPT
PAINT.PRG
PAINT.PRT
PAINTO.RSC
PAINT1.RSC
PAINT2.RSC

README.DOC

This folder contains the GDOS program file and
ensures that GDOS is automatically installed.

This folder contains several GEM font files as well as
a printer driver suitable for Epson FX series printers
and compatibles.

ATTRI10.FNT 10 Pt .Dutch font - hi/lo res.
ATTRI10CG.FNT 10 Pt. Dutch font - med.res.
ATTR12.FNT 12 Pt. Dutch font - hi/lo res.
ATTR12CG.FNT 12 Pt. Dutch font - med. res.
ATTRI18.FNT 18 Pt. Dutch font - hi/lo res.
ATTR18CG.FNT 18 Pt. Dutch font - med. res.
FX80.SYS Epson FX80 printer driver

GDOS font and driver configuration information.
Default set of brushes used by HyperPaint.

Default set of colour fill patterns used by HyperPaint.
Default set of mono fill patterns used by HyperPaint.
Data file for the HyperPaint printing utility.
HyperPaint printing utility default settings file.
HyperPaint program file.

HyperPaint printing utility.

Low resolution HyperPaint resource file.

Medium resolution HyperPaint resource file.

High resolution HyperPaint resource file.

A document containing information on the latest
release of HyperPaint.
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GETTING STARTED

LOADING HYPERPAINT

To load HyperPaint switch on your system in the normal manner and ensure that
GDOS has been correctly installed.

Ensure that the system is in the screen resolution that you require. On a colour
system use the Desktop SET PREFERENCES option to change from medium to
low resolution or vice versa. HyperPaint will run in any of the ST's three
resolutions.

Obtain a directory of the drive or folder containing the HyperPaint program files.
Unless HyperPaint is being run from hard disk, this will normally mean double-
clicking on the A disk icon from the GEM Desktop.

Move the mouse pointer to the PAINT.PRG program icon and double-click to
start loading. 520ST owners can increase the number of graphics workstations
available to HyperPaint by holding down the "Alternate’ key while the program is
loading; this prevents additional fonts from being installed. After a short while,
HyperPaint's startup screen appears.




THE SCREEN LAYOUT

The HyperPaint screen layout consists of four elements, A menu bar used to
configure the various painting tools, an icon bar used to select and configure the
tools, a palette to select the current drawing colour, and a large work area where
painting takes place.

Desk File Options

THE MENU BAR

The menu bar consists of three menus: Desk, File and Options. The
way the menus are invoked should be no secret to any Atari user who has
ever used the GEM desktop: Pointing the mouse cursor on a menu title
causes the appropriate menu to "drop down’; you then select the menu
option that you want.




THE SCREEN LAYOUT

THE ICON BLOCK

The icon block running down the left-hand of the screen contains nine
individual icons, each representing one of HyperPaint’s drawing tools.
Clicking once on an icon selects that particular tool for use; double-clicking
on an icon displays the configuration menu or dialog used to choose or
disable features associated with that drawing tool.

THE PAINTING AREA

HyperPaint’s painting area is within the large window occupying most of
the screen. Painting normally takes place within this window, although it is
possible to use the entire screen by pressing the right-hand mouse
button or pressing the "Help’ key.

THE PALETTE

The palette is used to to select the current working colour. It operates in a
similar way to HyperPaint’s icon block; clicking once on a colour selects it
for use, double-clicking on any colour displays a dialog allowing you to
replace that colour with any of the ST’s 512 colours.

On monochrome systems the palette allows you to select either black or
white as the current colour. Double-clicking on any part of the palette will
reverse the current palette.




THE DESK MENU

About HyperPaint
UT52 Emulator
Control Panel

Set RS232 Config.
Install Printer

About HyperPaint

Selecting this item invokes an alert box
containing information such as the
program name, a copyright notice, the
author’s name etc.

Desk Accessories

GEM allows up to six desk accessories to
be installed at boot-up time; if you have
installed any, their names will appear in
this menu. Desk accessories can consume a
lot of memory and it is therefore advisable
to keep them to a minimum (or zero if you
are using a 520 ST) if best use is to be
made of HyperPaint.




THE DESK MENU
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THE FILE MENU

Save

Save as ...
Abandon
Delete

Load defaults
Save defaults
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Save as ...
Abandon
Delete

e v v oo 2o o0 200 00 00 B0 B0 D00 N0 00 00 200 |

Load defaults
Save defaults.

e e e e D o0 S0 00 00 00 B0 D00 N0 N0 0 0 |

e e s De e o S0 0 N 0 B 0 AN 0 0 00 |

New

This menu entry prints an alert box to give
you a chance to reverse your decision; if
you don't, it clears the current workstation
and resets the window name to

UNTITLED.???

where '?7?7?" is the file extension of the
current picture format.

If you are working on an ’irregular’ (i.e.
larger than screen size) IMG file (only
possible with workstation 1), the 'Set IMG
size’ dialog appears so that you can choose
a different canvas size.

Open

A warning message i< displayed asking
you to reconsider; if you decide to go
ahead, the standard GEM file selector
appears, showing all picture files in the
current folder that match the file extension
of the picture format you are working with
(*.NEO, *.PI1 etc).

Select a picture and click on "OK’ or
double-click on a picture name. The file
will be loaded in memory replacing the
previous contents of the current
workstation.




THE FILE MENU

Save as ...
Abandon
Delete
Load defaults
Save defaults

oov 200 one 000 00 D00 000 200 BN BN 00 D00 MO B 00 00 )

000 200 M0 000 200 100 00 000 200 00 00 P00 M0 200 800 B0 0]

Save
Abandon !
Delete

oo aoe oot o0t 200 200 200 200 400 200 200 200 00 00 200 w00 20|

Load defaults
Save defaults

o aov are 0c 200 200 000 000 200 200 00 00 00 D00 200 200

Save

The GEM file selector appears, with its
filename field already filled-in with the
name of the current workstation. Pressing
the Return key or clicking the mouse
button on 'OK’ saves the picture to disk;
alternatively, you can cancel the operation.
If the current filetype is IMG you are also
given the option to save the current colour
pallete as part of the IMG header.

Save as ...

The GEM file selector appears, with its
filename field left blank. You can type in a
new filename (making sure you use the
correct extension) or select a file with the
mouse pointer in which case the selected
file will be replaced by your picture.
Pressing the Return key or clicking the
mouse button on 'OK’ saves the picture to
disk; alternatively, you can cancel the
operation. If the current filetype is IMG
you are also given the option to save the

Output current colour pallete as part of the IMG
~~~~~~~~~~~~~~~~~ header.

Quit
E-2




THE FILE MENU

| File I
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Open

Save

Save as ...
Abandon
Delete
Load defaults
Save defaults

e o0 one one 200 200 00 00 00 B0 D00 D00 M0 00 200 0 20|

e 00 a00 o0t 200 200 00 00 B0 B0 000 D00 200 200 00 200 00|

Save as ...
Abandon

Load defaults
Save defaults

(e v e o0 o0 o 00 0 100 10 Doe doe o0t B0t 200 00 |
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Abandon

A warning message is displayed asking
you to reconsider; if you decide to go
ahead, the GEM file selector appears, its
filename field already filled-in with the
name of the current workstation. Pressing
the Return key or clicking the mouse
button on 'OK’ replaces the current picture
with its last saved version; alternatively,
you can cancel the operation.

Delete

After the GEM file selector is displayed,
use the mouse pointer to select any one of
the displayed files. Double-clicking or
pressing 'Return’ or selecting and clicking
on 'OK’, prints a warning message; if you
still want to go ahead, the file is deleted
and you can select another file. This allows
you to delete a number of files with a
single operation. Click on 'Cancel’ to
finish.




THE FILE MENU

New
Open
Save
Save as ...
Abandon
Delete
Load defaults
Save defaults

Save as ...
Abandon
Delete

Load Defaults

Selecting this option allows you to load the
default fill pattern and brush files:

DEFAULT.MFL
DEFAULT.CFL
DEFAULT.BRS.

These are normally loaded when
HyperPaint is run, but if in the course of a
session you modify either fill patterns or
brushes, Load Defaults allows you to
easily revert back to the default styles.

Save Defaults

This option lets you replace the current
default fill patterns and brushes with
different ones. It permanently changes the
three default files:

DEFAULT.MFL
DEFAULT.CFL
DEFAULT.BRS

so that the new versions are automatically
installed when HyperPaint is loaded. Only
do this if you have safely backed up the

default files supplied with this program.




THE FILE MENU

| File

Hew

Open

Save

Save as ...
Abandon
Delete

P

Load defaults
Save defaults

New

Open

Save

Save as ...
Abandon
Delete

Load defaults
Save defaults

e a0 BW0 00 O N DO DO BN NG N8 D00 0 200 207 00 200
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Output

Clicking on this menu entry exits the main
program and runs a special printing utility
called '"PAINT.PRT".

You can return to HyperPaint from the
printing utility by selecting the 'Quit’
option in the 'File’ menu. Alternatively,
you can return to the GEM Desktop by
selecting the same "Quit’ option while
holding down the ’Alternate’ key.

Further information on using the
HyperPaint print utility can be found in
Appendix B

Quit

This option allows you to exit HyperPaint
and return to the GEM Desktop. An alert
box is displayed offering you the option of
either saving your work and returning to
the program or simply quitting to the
desktop.
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THE OPTIONS MENU

Options
Filetype
Pen

Brush
Spray
Fill
Blocks
Text
Shapes
Zoom

Miscell.

Options

Pen
Brush
Spray
Fill
Blocks
Text
Shapes
Zoon
Miscell.

Filetype

The 'FILE OPTIONS' sub-menu drops
down, showing all available file formats
(NEO, Degas etc). The currently selected
one is ticked and you can choose a
different format by simply clicking the
mouse button on it. The filetype applies to
all available workstations.

FILE OPTIONS
HED fornat

v DEGAS normal
DEGAS compressed
IMG format

Pen

This menu entry causes the pen selection
dialog box to appear; this can also be
achieved more directly by double-clicking
on the PEN icon. Eight pen thicknesses are
available, the current one being
highlighted. The selected pen thickness
also determines the border line thickness
used by all unfilled shapes.
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THE OPTIONS MENU

Options Brush

Filetype

P;I'I up The 'BRUSH OPTIONS’ sub-menu drops
down showing the following additional
selections:

Blocks BRUSH OPTIONS

- S R el s R i

Shapes Select Brush B

Zoonm Load Brushes

Miscell. Save Brushes

Save as...
The first entry, 'Select brush’, allows you
to choose one of eight brush shapes, edit
any one of them or choose to use the
current block as a brush.
Sets of eight brush shapes can be saved to
disk or loaded from disk using the file
extension ".BRS’. The file
'DEFAULT.BRS’ must always be on your
boot disk for the program to find and load
when it is first run.
More details on brushes will be found in
the section on Painting Tools.
F-2



THE OPTIONS MENU

Filetype
Pen
Brush

Fill
Blocks
Text
Shapes
Zoon
Miscell.

Filetype

Pen

Brush
SErai
Blocks

Text

Shapes
Zoom

Miscell.

Spray

This menu entry causes the spray dialog
box to appear; this can also be achieved
more directly by double-clicking on the
SPRAY icon. The dialog allows you to
select either a small, medium or large spray
nozzle as well as setting the spraying speed
using a six-step slider.

The section on the Painting Tools describes
the spray in more detail.

Fill

The 'FILL OPTIONS’ sub-menu drops
down offering the following choices:

FILL OPTIONS
Mono fill 0
Lolour #1111 ®
Load Patterns
Save Patterns
Save as...

Fill Mode BH

The first two options let you select the fill
pattern of your choice as either a
monochrome or colour 16 by 16 pixel
pattern. If you are using a monochrome
monitor, the "Colour Fill" menu entry is
disabled.
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THE OPTIONS MENU

Filetype
Pen
Brush
Spray
Fill

Text
Shapes
Zoon
Miscell.

"Load’, 'Save’ and 'Save as. ' allaw vou
to load or save complete sets of Ju patieiis
depending on your choice of Monochrome
or Colour mode. The extension ".MFL’ is
used for monochrome fills while ".CFL’ is
used for colour.

The "Fill Mode’ lets you select from
"Replace’, 'Transparent’, 'Invert’” and
"Reverse Transparent’ writing modes.

More on fill patterns will be found in the
section on Painting Tools.

Blocks

Blocks are rectangular sections of a picture
which can be defined (CUT) by the user
and then saved to disk, pasted elsewhere on
the picture, rescaled, stretched, rotated,
skewed etc.

This menu entry causes the 'BLOCK
OPTIONS’ sub-menu to drop down,
allowing you to pick one of the many
block manipulation operations.

F-4



THE OPTIONS MENU

Filetype
Pen
Brush
Spray
Fill
-Bll:?"“q
Shapes
Zoom
Miscell.

These are:

BLOCK OPTIONS
Cut Block &M
Paste Block EH
Rescals 04
Stretch ;
Rotale
Flip Horiz,
Flip Vert,
Sken Horiz,
Sken Yort,
futiine
Sngoth
Paste Mode
Load Block

Save Block

Saue 88, ..

-

WY YEX YRX YHX Y ¥,
CORSOBC IR ORI RS

%,
2

X yex
2842

DC T % O e 3t RF s e

[
[< OS2

and are fully explained in the section on
Painting Tools.

Text

The 'TEXT OPTIONS’ sub-menu drops
down offering the following options:

TEXT OPTIONS
Font BI
Orientation @J
Style 8K
Writing Mode &L

F-5



THE OPTIONS MENU

The "Font’ option lets you select the
typeface (font) and the character size in
typographical points. The default font is
"System’ which is the ST’s ROM-based
font.

Additional fonts (see Appendix A for font
installation instructions) are loaded when
the program is first run unless the
"Alternate’ key is held down during
loading.

The "Orientation’ option determines
whether the text is printed from left to
right, right to left, upwards or downwards.

The "Style’ option caters for text effects
(Normal, Bold, Italic, Underlined, Outlined
and Light) as well as text justification
(Left, Centre or Right).

The "Writing Mode’ option allows you to
select from a total of four modes:
'Replace’, 'Transparent’, "Invert’ and
'Reverse Transparent’ and thus determine
how the text is combined with the existing
picture.

The Painting Tools section explains the
text options in more detail.




THE OPTIONS MENU

Filetype
Pen
Brush
Spray
Fill
Blocks
Text

Zoon
Miscell.

Shapes

The 'SHAPE OPTIONS’ sub-menu (also
available by double-clicking on the Shapes
icon) drops down offering the following
two options:

SHAPE OPTIONS

e e O A D0 NG AL O BN NN N O DO N 00 D0 0 200 |

Select Shape @A
Set parameters HC

"Select Shape’ displays the Shapes dialog
box which enables you to select one of 18
geometric or mathematical shapes. The
selected icon is outlined and the shape it
represents becomes the current shape as
soon as you press 'Return’ or click on the
"OK’ button. The same dialog box can also
be arrived at by simply pressing "Alt’ and
A’ together.

The following shapes are available:

Unfilled Filled

Lines

Continuous Lines

Rays

Curves

Triangles Triangles
Rectangles Rectangles
Squares Squares
Circles Circles
Ellipses Ellipses
Circular Arcs Circular Arcs
Elliptical Arcs Elliptical Arcs

The ’Set parameters’ sub-menu entry
displays a dialog box in which one of eight
line "types’ can be selected as well as the
option to outline or not the seven available
filled shapes. It is worth noting here that all
line types revert to solid if a line (pen)
thickness of more than one pixel is
selected.
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Filetype
Pen
Brush
Spray
Fill
Blocks
Text

ShaEes
Miscell.

Zoom

The "ZOOM OPTIONS’ sub-menu is
displayed, offering a choice of four "entry’
magnification factors:

ZOOM OPTIONS

e o0 A0 0 00 NP O D DO NG B0 B0 D A

Zoon X 16

The selected zoom factor is ticked and is
used each time you enter the Zoom mode

as a 'start’. Of course, once in Zoom mode,

you can decrease or increase the
magnification factor in steps of one from 2
to 16 times actual size.

The sub-menu can also be produced by
double-clicking on the Zoom icon.

The Painting Tools section of this manual
covers the Zoom operation in more detail.




THE OPTIONS MENU

m Miscell.
Filetype

Pen The 'MISC. OPTIONS’ sub-menu drops
Brush down offering the following miscellaneous
S;ray options:
Fill
Blocks
Toxs MISC OPTIONS
Shapes | [Tt
Zoo: Clear screen &D
Smear
Cycling b
Mirror

B L T T R pperppIp

Set Lucling ®2
Set Mirror

Set Palette
Load Palelte
Save Paletts
Work Manager ®E
Set .IMG size

MISC OPTIONS Clear screen (Alt D)
After a warning alert box that allows you
to change your mind, the current

Smear workstation screen is cleared.

Cycling 0

Mirror

e s e e B BN O B DI BN NG OO0 B0 PO DO N0

Set Qycling BZ
Set Mirror

Set Palette
Load Palette
Save Palette
Work Manager ®E
Set .IMG size
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MISC OPTIONS

Clear screen &D
Lucling By

Set Lucling 2
Set Mirror

Set Palette
Load Palelle
Saye Palelte
Work Manager XE
Set .IMG size

MISC OPTIONS

WA h VA WA A A A WA A WA WA WA WA WA WA A WA WA

Clear screen ¥D

WA WA WA WA A YA VA WA VA WA WA WA WA WA A A WA A

Set Cycling ®Z
Set Mirror

Set Palette
Load Palette
Save Palette
Work Manager EE
Set .IMG size

Smear
Mirror !

Smear

This is a "toggle’, that is it changes state
from selected (ticked) to non-selected (un-
ticked) each time you click on it. If it is
selected, it modifies the operation of the
spray tool so that the colour used for each,
randomly produced, spray dot is decided
upon by randomly reading pixels from the
spray’s target area (the screen area
encircled by the spray’s nozzle outline).

The effect this has on the sprayed area is
that adjacent colours are 'mixed’ and their
edges smoothed over by pixels of one
colour being sprayed onto regions of the
other and vice versa. For example, if you
move the spray cursor over the boundary
of, say, a blue and a white area, random
blue pixels will be 'diffused’ into the white
area and white pixels into the blue area.
The visual result will be that of a
reasonably smooth transition from one
colour to the other.

Cycling (Alt Y)

This option acts as an "ON/OFF’ switch for
the colour cycling operation. The sub-
menu entry is ticked if cycling is enabled

and un-ticked when colour cycling is
disabled.
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MISC OPTIONS

a0 00 e 00 M0 B0 SO NG B0 B0 O D00 D00 200 B0 e 0

Clear screen &D

Set Bycling 2
Set Mirror

Set Palette
Load Paletle
Saye Paletis

v e D N B B DO DO N N D00 0 D00 D00 00 e

Work Manager SE

Set .IMG size

MISC OPTIONS
Clear screen &D
Smear

Cycling ay
Mirror

[ WAA WA A A L WA AR A WA VA WA WA WA A A e

Set Mirror l

Set Palette
Load Palette
Save Palette
Work Manager uE
Set .IM6 size

Mirror

Like 'Smear:, this toggles the Mirror
option on and off. Mirroring is supported
by the Pen and the Brush (in the non-block
mode) and can produce some very
interesting and decorative effects.

Set cycling (Alt Z)
Cycling a selected range of colours from
the current colour palette can add an extra
dimension to your pictures. Careful choice
of colours can produce an impression of
animation whose speed and direction is
user-defined.

This sub-menu entry displays a special
dialog box thrcugh which you can set the
range of colours to cycle, the speed of
cycling (from approximately 50 'steps’ a
second to about 1/2 a step a second) and
the direction ('left’ or 'right’). Test buttons
allow you to examine the cycling palette
("Test’) or the complete picture (' View’).

Select Cucling Range

Select Cuycling Speed

Select Direction

| Test | |  View 1

| Cancel | | 0K I k il
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MISC OPTIONS
Clear screen &D
Smear
Cucling By
Mirror

B R PO PR P prvperprvperpwpen

Set Palette
Load Palette
Saye Balette
Work Manager BE
Set .IMG size

A copy of the colour palette at the top of
the dialog box lets you define the range
(marked by means of the two ’bar’
delimiters under the colour boxes). To do
this, click the left-hand mouse button on
the colour box you want the cycling to start
from, and, without releasing the button,
"drag’ it (towards the right!) to the last
colour you want in the sequence; then let
go of the button. The markers will be
positioned under the colours of your
choice.

The colour cycling speed is set using a
conventional GEM slider: Increase the
speed by moving the slider to the right (by
"click-and-dragging-it’ or clicking on the
right arrow) and decrease it by moving the
slider to the left or clicking on the left
arrow.

If the filetype is NEO or DEGAS, saving a
colour picture also saves the colour cycling
information. Only one set of colour cycling
data is supported and it is therefore shared
by all available workstations.

Set Mirror

The "Set mirror’ dialog box is printed on
the screen. It displays three options;
Horizontal, Vertical and Diagonal.

Any combination of them can be set by
simply clicking on the appropriate options
to select them. To de-select an option that
is enabled, just click the mouse button on
the appropriate "button’.
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An invisible set of x-y axes, intersecting
each other at the centre of the work area
act as axes of symmetry for horizontal and
vertical mirroring; their intersection
providing a centre of symmetry for
diagonal mirroring.

The work area is thus divided into
4 quadrants which we shall number 1,2,3,4:

Desk File Options
iy

Let’s assume that you are drawing on the
3rd quadrant. Here is a table showing what
you should expect depending on your set
mirror options:

Option Writing on

Horiz.

Vert.

Diag.

Horiz. + Vert.

Horiz. + Diag.

Vert. + Diag.

Horiz. + Vert. + Diag.

ANRAR A
+ 4+ + +
B — — N0
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MISC OPTIONS
Clear screen ©D
Smear
Lucling By
Mirror
Set Lucling B2
Set Mirror

foad Palelle

Saye Palelte

o a A BN 0 DN DN NN PO B D00 N 0 0 0 |

Work Manager BE
Set .IMG size

Set Palette (or double-click on any

palette colour)

If this option is selected on a monochrome
system, the Black and the White palette
boxes are inverted and therefore,
background and foreground 'colours’ are
exchanged.

In colour, a dialog box is displayed
consisting of the following:

elect

B

(1) R,G and B vertical slide bars showing
graphically the Red, Green and Blue
proportions of the current palette colour.

The RGB mix can be varied by either
"click-and-dragging’ the appropriate colour
slider or clicking on the up or down arrows
of each slide bar.

Each slider can represent up to eight

"steps’ of participation in the overall mix, O
to 7. Selecting a different colour from the
palette at the bottom of the screen , updates
the slide bars accordingly.

(i1) A numerical display of the RGB
proportions consisting of three digits, one
for each of the primary colours, which is
also updated when a colour is selected or
mixed. Each digit can vary from O to 7.
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(iii) "'Review’. Clicking the left-hand
mouse button on this and holding it down
takes you to the full screen to take a look at
the way your palette changes have altered
the appearance of the picture. Releasing the
mouse button returns you to the colour
selection dialog. If the mouse button is
pressed while holding the "Alternate” key
down, and you position the centre of the
cross cursor over a pixel on the main
screen, returning to the dialog box makes
the colour of that pixel the current palette
selection. This is useful if it is visually
hard to distinguish between very similar
colours on the palette.

(iv) "Select’. A single click on this dialog
entry, takes you on a trip to the colourful
world of the ST’s full palette of 512
colours.

Clicking on any of the 512 narrow strips
updates the colour of the large rectangle at
the extreme right and shows the RGB mix
of that colour. Once you have selected a
colour, click anywhere inside the large
rectangle to return to the main dialog. The
currently selected palette position adopts
the colour you chose.

(v) 'Restore’. This lets you re-instate the
ST’s default palette i.e. the palette the ST
boots up with. You are offered a chance to
cancel.

(vi) "Cancel’ and 'OK’. These have the
usual effects of cancelling all changes or
accepting them, respectively.
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MISC OPTIONS
Clear screen ®D
Smear
Cycling sy
Mirror
Set Cycling ©Z
Set Mirror
Set Palette
Load Palette
Save Palette

WA WA WA VA A A WA AR A A WA A VA VA YA WA WA WA

Work Manager ©E

| Set .IMG size

If, whilst the colour selection dialog is
displayed, you click on a palette position
and then 'drag’ the mouse towards the
right, defining a 'rubber’ rectangle joining
up two colours, releasing the mouse button
causes all the intermediate palette boxes to
adopt shades between the start and end
colours in a properly graded fashion. For
example, if position 1 (extreme left) of the
palette is WHITE and position 8 is
BLACK, joining them up produces a
complete grey scale from white to black.
You might find that some of these
intermediate colours are repeated; this
happens if there are fewer possible colours
between the two limits than there are
available palette positions. This feature is
particularly useful if effective "smoothing’
or anti-aliasing of blocks is desirable.

Load/Save palette

These two entries allow you to load or save
Just the colour palette of the current
workstation for future use without having
to load/save the complete picture. A file
extension of 'PA1’ is used for Low
resolution palettes while 'PA2’ is used for
Medium.




THE OPTIONS MENU

MISC OPTIONS
Clear screen ©D
Smear
fucling By
Mirror
Set Lycling B7
Set Mirror
Set Palette
foad Balette
Save Palette

e e a0 D00 0 O AP DO DO DO DO TN BN DO B0 B0 PO A

Work Manager UE
Set .IMG size k

Work Manager (Alt E)

This entry brings up the Workstation
Management dialog box which lets you
Select, Copy or Clear workstations.

Horkstation Hanagenent

Clear mode:

Cone ] N

To select a particular workstation
(although this is much much easier done
using a function key!) just click on one of
the available workstations and then click
on OK or press Return. If you have clicked
on a workstation box by mistake and don’t
quite remember what your current
workstation is, click on "Cancel’.

To copy the CURRENT workstation to
another one, click on the desired
destination, decide on the Copy mode
(Palette only, image only or both) and then
click on COPY. The current workstation is
shown by being highlighted.

To clear the current workstation, select
"ONE’ as the Clear mode and then click on
CLEAR.

To clear all workstations (up to 10 on a
1040 ST or a Mega ST), select 'ALL’ as
the Clear mode and then click on CLEAR.
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MISC OPTIONS
Clear screen ®D
Smear

Cycling By
Mirror

Set Bucling 2
Set Mirror

Set Palette

Load Paletle
Save Paletie

O O AN BN O BN N DO DO NN NG BN P DO D00 BN 0

Work Hanager ®E

Set IMG size

This option only works if the selected
filetype is IMG and the current workstation
is number 1. (Workstation 1 is the one to
use if you want to load or create an IMG
file which is not 'screen-sized’). An alert
warns you to that effect.

Selecting the "Set IMG size’ option
displays a dialog box with 4 pre-set picture
sizes and an option to view the complete
IMG file. Click on a picture size to select it
and then press Return or click on OK. The
size will be adopted if there is enough
memory to satisfy the request.

Select .IMG size

2.
g

(a0 [

If you want to preview your picture select
the ’Set IMG size’ menu option and click
on the "Show Pic’ button to get a "best-fit’
representation of your whole painting.
Clicking the left-hand mouse button erases
this picture and takes you back to the main
screen.

Note that very large IMG pictures
(typically 400-500K of scanned images on
a 1040 ST) will need to be scaled down for
this display, so be patient!
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THE PAINTING TOOLS

The nine icons on the left-hand side of the screen represent your drawing
and painting tools.

A single click of the left-hand mouse button on any of these icons selects
that particular tool and the current painting mode (filling, magnifying etc).
The tool remains active until another one is selected (with the exception of
the KNIFE which automatically selects the block icon immediately a shape
is jack-knifed).

Double-clicking on a tool icon brings up a dialog box or a sub-menu
enabling you to set the parameters or options pertaining to that particular
tool. For most tools, there is also an entry in the 'Options’ menu which
allows you to set or change the parameters for a certain tool even if another
tool is currently active. In this way a different pen thickness can be chosen,
for example, while you are in the middle of drawing lines or curves using
the Shapes tool.

You can only select a tool if you are in the "'window’ mode although most
tool options can be set in the full-screen mode by using keyboard
shortcuts.

The various tools and their options are described in the following sections.
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PENS

FEN

The Pen is a simple drawing tool which could be used to
roughly sketch your picture before editing it in detail using
zoom, or to erase parts of it by drawing with a suitable
background colour.

Eight pen thicknesses are available, these also determine the
line thickness used by the Shape tool for creating the border
of all unfilled shapes.

To invoke the pens dialog either double-click on the pen icon
or choose 'Pen’ from the 'Options’ menu. The first method
switches you to the Pen mode (if you are not already there)
while the second allows you to set a thickness without
leaving your current tool.

_/mam

g/oo

CANCEL =]

Once the pen selection dialog is displayed, select the current
pen thickness and click on OK or press Return.
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BRUSHES

BRUSH

The Brush is a more versatile tool than the Pen and is
normally used for more detailed work or special effects.

In addition to the eight single-colour brushes any rectangular
picture block defined (CUT) using the BLOCK tool, can also
act as a brush; brushes always operate in the Transparent
mode and, therefore, any elements of background colour (the
left-most colour in the palette) in the brush/block will allow
the picture underneath to show through.

To select the tool, click on the Brush icon. If the current
brush is not a picture block, the cursor will change to the
brush shape.

To select a brush, double-click on the brush icon or choose
'Brush’ from the 'Options’ menu followed by ’Select Brush’
in the 'Brush Options’ sub-menu (' Alternate B has the same
effect). The brush selection dialog will appear.

Cise glock ] Edit drush
[CANCEL ISR OK |

A brush is selected by clicking on the square containing the
brush shape you wish to use and then clicking on OK or
pressing Return.
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The eight available brushes can then be edited by selecting
any one of them and clicking on "Edit Brush'.

If a picture block has been defined (CUT), the 'Use block’
button will be enabled thus becoming the ninth possible
choice. If this option is chosen, 'Edit Brush’ becomes
inactive.

Brushes can be saved to disk or loaded from disk as ".BRS’
files. A .BRS file contains the definitions of all eight brushes.

A brush file called 'DEFAULT.BRS’ is loaded when the
program is first run, providing a default set of eight brushes.
(Make sure there always is a "'DEFAULT.BRS’ file on your
program disk). You could rename your favourite brush file to
'DEFAULT.BRS'’ (provided you make a copy of the one
supplied on your master disk for safe keeping) so that the
brushes of your choice are loaded in by default.




SPRAYCAN

&

SPRAY

The Spray or airbrush randomly sprays a fixed, circular area
with groups of single pixels in a manner not dissimilar to that
of a painter’s spray-gun.

Desk File Options
D:\PAINT\UNTITLED.PI3

Like all the other tools the Spray is selected by clicking the
left-hand mouse button once on the spray-can icon.

To set the characteristics of the Spray, double-click on the
spray-can icon or select 'Spray’ in the "Options’ menu.

Spray size:

[Snall | IIXTRN[ Large |

Spray speed:

= r

| I]K‘] | Cancel |
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SPRAYCAN

The dialog box which appears also lets you choose one of
three spray sizes: small, medium and large, as well as one of
six possible spray speeds; the speed is reduced or increased
by clicking on the left or right arrows respectively, or by
simply 'dragging’ the slider to the required position.

When the spray is used, the cursor is replaced by a nearly
circular outline enclosing the "target’ area. The current
palette colour is normally used unless the 'Smear’ option has
been enabled from the 'Miscellaneous’ sub-menu, in which
case the colour used is decided upon by randomly reading
pixels from the spray’s target area.
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FILL PATTERNS

FILL

The fill mode is selected by clicking the left-hand mouse
button once on the fill icon.

Double-clicking on the icon brings up the 'Fill options’ sub-
menu which allows you to select monochrome or colour fills,
save or load fill pattern files, and set the fill writing mode.
The same sub-menu can be produced by selecting "Fill" in
the 'Options’ menu.

36 monochrome fill patterns are available in addition to a
further 36 colour patterns if a colour monitor is attached. The
selection dialogs for monochrome or colour fill patterns are
normally invoked by clicking on the appropriate fill sub-
menu entry. Alternatively, each dialog can be displayed
directly from the keyboard by pressing either "Alt F" for
monochrome or "Alt G’ for colour.

%M
CANCEL oK &

Each dialog box consists of 36 small rectangles each filled
with one of the 36 patterns and a large rectangle which
indicates the current selection. Clicking on any of the small
filled rectangles updates the large one with the new fill
pattern. Clicking on the 'OK’ button fixes the selection and
makes the last selected pattern the current fill.
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FILL PATTERNS

If the left-hand mouse button is clicked inside the large
filled rectangle, the dialog box is replaced by the "Edit Fill’
dialog; you can now customise the current fill pattern (or any
one of the 36 by using the left and right arrow buttons on
either side of the large rectangle that displays the 1:1
pattern).

Hake Fill

If you are editing a monochrome pattern, clicking the left-
hand mouse button inside the editing rectangle has a toggling
effect: white pixels turn black and vice-versa; For colour
patterns, you pick up the desired colour from the standard
palette.

The 'Capture’ button is enabled when editing a colour fill
pattern. Clicking on it takes you to a full-screen display of
your picture where a transparent, rectangular cursor lets you
define a 16 x 16 pixel area as the current fill pattern. Once
you are over the desired part of the picture, click the left-
hand mouse button again to return to the fill pattern editor.
The area enclosed by the cursor will then become the new
fill pattern.

Once a monochrome or colour fill is selected, it becomes the
"current’ filt and is used whenever the 'fill’ tool is active to
fill an enclosed area. Filling takes place from the point the
mouse button was clicked until a different boundary colour is
found. As soon as the fill tool is chosen, the cursor changes
to a tilted jug and the cursor "hot-spot’ is the tiny drop of
paint which appears to have just left the spout. It is this hot-
spot that must be inside the area to be filled when the mouse
button is pressed.

K-2



FILL PATTERNS

If the area you are filling is not completely enclosed, the
paint will "leak’ into other areas; in this case, wait for the fill
to end, press UNDO to restore the previous state of your
canvas and then edit the boundary to eliminate the 'leak’.

Avoid filling areas which have already been filled with some
fine, dotted pattern or such like; the fill algorithm will be
faced with the horrendous task of working its way through a
complicated maze of "boundary’ pixels and might, therefore,
take a very long time.

Sets of fill patterns (all 36 of them) can be saved to disk or
loaded from disk by selecting the appropriate sub-menu
entry. If the current fill is a mono pattern, Load and Save
will automatically adopt the extension .MFL and only
operate on the monochrome fills. Similarly, if the current fill
is a colour pattern, a colour mode will be assumed and the
extension .CFL will be used.

Two fill pattern files will be found on your master disk:

DEFAULT.MFL
DEFAULT.CFL

These are loaded in automatically when you first run the
program. If, at any point you would like to restore the default
fill patterns and brushes (after, perhaps, some unsatisfactory
editing etc), click on the 'Load defaults’ entry in the "File’
menu. Similarly, if you would like a certain set of fills and
brushes to become your start-up defaults, use the 'Save
defaults’ entry of the same menu. Don’t forget to make
backups of the files supplied on your master disk as 'Save
defaults’ will over-write the following files.

DEFAULT.BRS
DEFAULT.MFL
DEFAULT.CFL




FILL PATTERNS

The 'Fill Mode’ entry in the 'FILL OPTIONS’ sub-menu
(" Alternate H') allows you to set the particular way in which
the fill pattern will be combined with the existing picture.

SELECT WRITING MODE

D Replace
D Transparent

D Invert

D Reverse Transparent

[concey I o v

In the 'REPLACE’ mode, the fill pattern simply over-writes
whatever was on the canvas before; it is perfectly predictable
for both mono and colour fills.

The remaining three modes will be explained in the context
of monochrome fills (i.e. one background and one
foreground colour).

TRANSPARENT: The pattern itself is superimposed on the
canvas while its background is made transparent (ignored)
and therefore the old canvas colours show through.

INVERT: The background of the fill pattern is again
transparent but all the pixels of the canvas which correspond
to the actual pattern are inverted. The current palette colour
is ignored and the only colours appearing in the filled area
are the old canvas colour (fill pattern background) and its
inverse (fill pattern foreground). Inverses of colours are
rather peculiar and difficult to guess in advance, so it’s worth
experimenting.
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REVERSE TRANSPARENT: As the name implies this is a
variant of the transparent mode. In this case it is the pattern
itself that becomes transparent and allows the old canvas to
show through while the pattern background is opaque and
painted in the current palette colour.
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BLOCK MANIPULATION

BLOCK

Any rectangular portion of a picture can be defined ('CUT’)
as a BLOCK.

The cut block can then be pasted back onto the original
picture or another workstation in its original form or after a
suitable transformation. It can also be saved to disk in a
.IMG format, ready to be imported into other applications
such as 1st Word Plus, HyperChart, Calamus, Fleet Street
Publisher and Timeworks DTP.

To select a Block operation:
Double-click on the Block tool (the rectangle below the paint
roller) or select BLOCKS in the Options menu. Once a block

operation has been chosen, it remains active and can be used
as soon as you select the Block tool by single-clicking on it.

CUT BLOCK (Alt M)

Desk File Options
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BLOCK MANIPULATION

This option is automatically selected when the program is
first run. To define a block:

®

(i1)

(ii1)

@iv)

Select the Cut Block operation as outlined above,
alternatively, select the Block icon and press the
Alternate and M keys together.

Move the cross-hair cursor to the point on your
canvas where you want the block to start.

Hold down the left-hand mouse button while moving
the cursor (now, a pointed hand) in any direction. A
rectangular outline with one corner fixed to the
original point will follow the cursor.

Define the block of your choice by releasing the
mouse button. The part of the original picture
enclosed by the rectangle will be removed while a
dashed outline is left to mark its place. This is the
default, but you can override it by holding the SHIFT
key down while going through steps (iii) and (iv). In
this case, a "snapshot’ of the defined area is taken
leaving the original picture intact. The dashed outline
will remain on the screen until the next operation.

If you accidentally cut a block without holding
SHIFT down, the picture may be restored by pressing
UNDO after releasing the mouse button. This does
not affect the contents of the 'cut buffer’.

After a block is cut, the PASTE option is
automatically selected and, therefore, you will have to
go through steps (i) to (iv) to define a different block.
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BLOCK MANIPULATION

PASTE BLOCK (Alt N)

Desk File Options
\PAINT\UNTITLED.PI3
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This option is selected automatically after a block is cut
using the CUT BLOCK option or the Jack Knife tool.
Alternatively, it can also be activated by clicking on the
'Paste Block’ option in the BLOCK OPTIONS sub-menu or
by using its keyboard shortcut: Alternate N.

6)) Move the cursor onto the canvas and click the left-
hand mouse button once. The cut block, surrounded
by a dashed outline, becomes visible and may be
moved freely around your painting area by moving
the mouse.
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(i1)  Use the mouse to position the block accurately and
then click the left-hand mouse button once. The block
is pasted ("stamped’) onto the canvas.

Desk File Options
D:\PAINTNUNTITLED.PI1

To paste the block again, repeat steps (i) and (ii). Pressing
ESC while moving the block around the screen cancels the
operation. The particular way in which the block is combined
with the existing picture is defined by the 'Pasting Mode’.

RESCALE (Alt O)
STRETCH (Alt P)

Desk File Options
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Rescale’ pastes a re-sized copy of the block onto the canvas
retaining the proportions of the original block.
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File Options
NEYEYEZ .PI1:

Stretch’ allows you to stretch or shrink either dimension of
the block and does not, therefore, always retain the original
proportions.

Having selected 'Rescale’ or ’Stretch’ from the BLOCK
OPTIONS sub-menu, do the following:

@

(D)

(i)

Move the cross-hair cursor to the point where you
want the top left-hand corner of the re-sized block to

be.

Hold down the left-hand mouse button. A dashed
outline indicating the actual size of the block appears,
its top left-hand corner coinciding with the point you
clicked on. As the mouse moves towards the right and
downwards, a new rectangle, anchored to the same
point, follows the cursor and is used to determine the
new width and height for the image to be pasted.

When you are satisfied with the new dimensions
release the mouse button.

The main difference between rescaling and stretching
becomes apparent here:

If you are stretching, the block is manipulated so that it fits
into the re-sized rectangle. (Remember, the original block is
safely kept in its own storage area and is not affected by
anything other than the next CUT).
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If you are rescaling, the height of the re-sized rectangle is
ignored and a new one is worked out so that the proportions
of the original block are retained.

ROTATE (Alt Q)

An existing block can be rotated around its centre in
increments of one degree; it can then be pasted to any of the
available workstations. To effect a block rotation do the
following:

0]

G

Having selected the 'Rotate’ option on the BLOCK
OPTIONS sub-menu, click the left-hand mouse
button once anywhere inside your painting area. A
dashed outline, representing the block, appears in the
middle of the screen. This can be rotated around its
centre as the mouse moves freely around the screen.
The rotation angle in degrees is displayed inside the
rectangle.

Desk File Options
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As soon as the desired rotation angle is shown, click
the left-hand mouse button once to fix it. The degree
display disappears and you will find that the pre-
rotated outline rectangle can be moved across your
canvas following the movement of the mouse.
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(iii)  When the rotated rectangle is over the position that
you wish to paste the newly rotated block, click the
left-hand mouse button once and the rotated block
unfolds on the canvas.

Desk File Options
A:\DOGS.PIC!
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UNDO can be used to remove the pasted block from the
screen while pressing ESC during steps (i) and (ii) cancels
the operation.

FLIP HORIZONTAL (Alt R)
FLIP VERTICAL (Alt S)

These operations are used to paste mirror images of the block
onto the painting area.

Desk File Options
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With horizontal flip, the left-hand edge of the original block
becomes the right-hand edge of the pasted block and vice-
versa. It is, therefore, a reflection around an imaginary axis
that runs right through the middle of the block.

The vertical flip is a reflection around a horizontal axis and
as a result, the top edge of the original block becomes the
bottom line of the pasted block and vice-versa.

Select one of the flip options from the BLOCK OPTIONS
sub-menu and then:

(6] Click the left-hand mouse button anywhere inside the
painting area. The cursor disappears and is replaced
by a dashed block outline which can be moved freely
across the canvas following the mouse movement.

(i) When the block outline is over the area you want the
flipped block to be pasted on, click the left-hand
mouse button. The 'mirrored’ block is pasted on your
canvas and the cross-hair cursor is restored.

UNDO and ESC perform their usual functions: UNDO
removes the pasted, flipped block and restores the canvas to
its previous state. ESC removes the moveable outline cursor
and cancels the operation during step (i).

SKEW HORIZONTAL (Alt T)
SKEW VERTICAL (Alt U)

The skewing procedure is identical to that for block rotation
except that now the free movement of the mouse in step (i)
alters the skew rather than the rotation angle.

Step (ii) fixes the skew angle while step (iii) pastes the
skewed block onto the canvas.

Again, pressing ESC while in steps (i) or (ii) cancels the
operation and pressing UNDO after step (iii) restores the
picture to its previous state.
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Desk File

OUTLINE (Alt V)
SMOOTH (Alt W)

These two operations should be considered to be operations
on selected areas of the canvas rather than general block
manipulations. They affect the part of the screen that the
original block was cut FROM and they should, ideally, be
used immediately after cutting a block (with SHIFT) so that
the on-screen picture still contains the block.

Both operations 'read’ information held in the "cut buffer’
and modify the corresponding section of the canvas based on
that information. (Special effects can be achieved, though, by
clearing the screen or switching to a different workstation).

Both operations require two mouse button clicks:

The first click draws a dotted rectangle around the area the
block was cut from (whether the block is still there or not)
marking it as a "target’ for the actual operations, while the
second outlines or smooths. The following explanations
assume that the first click has already taken place.

-9



BLOCK MANIPULATION

OUTLINE

When this option is selected from the BLOCK OPTIONS
sub-menu, clicking the left-hand mouse button over a pixel
inside the area where the block originated from causes the
colour of that pixel to be identified. Then, all the regions
within the block, which are painted the same colour, receive
a single-pixel outline in the currently chosen palette colour.

Desk File

For example: If the current palette colour is red and the
mouse button is clicked over a yellow pixel inside the area
the block came from, all yellow regions bounded by the
block dimensions will be outlined in red.

SMOOTH

This is a software image-filter. In monochrome, it scans the
block from top to bottom and eliminates single, isolated
pixels ("Spot noise’). The apparent result is that certain
digitised pictures of a rather "dotty’ appearance may be made
to look cleaner by resembling high contrast, line-drawings.

In colour (particularly in low resolution), areas of abrupt
intensity changes are identified and their edges are blurred
by choosing the most appropriate intermediate shades from
the current palette. For example, jagged lines and transitions
from one colour to another are smoothed by filling the
corners with pixels of the best available colour.
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Desk File Options
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The "anti-aliasing’ algorithm used is more effective if your
current palette contains a few colours which lie between the
ones you want to blur. For example:

To smooth-the "staircase’ look of a black "A" printed on a
white background, make sure the palette contains two or
more shades of grey. (Double-click on a palette colour to get
the 'Set palette’ dialog box and 'click-and-drag’ to join up
two colours and define a range of shades between them).

PASTING MODE (Alt X)

Like the "Fill mode’, the pasting mode determines how the
block is pasted onto the existing picture. The same modes
(Replace, Transparent, Invert and Reverse Transparent)
apply and these are fully described in the section on Fill
Patterns.

The Pasting mode is only relevant if 'Paste’ has been
selected; it does not apply to the other block functions which
always use a 'Replace’ mode.
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LOAD/ SAVEI SAVE AS...

Saving and Loading Blocks is one of HyperPaint’'s major
features. Not only can you transfer blocks from one picture
to another via a disk but you can also export your blocks to
other packages such as Word Processors and Desk Top
Publishing programs.

To achieve this, a popular storage format is used, Digital
Research’s bit image standard for picture files:- IMG. (You
will notice that the IMG format is also one of the types
supported for complete images by this program). We have
extended the formal definition of an IMG file which, as it
stands, has no means of dealing with colour palettes other
than the default colours, by extending it to include palette
information. Applications that address IMG files correctly
will ignore this additional information, however, to cater for
"badly behaved’ programs you are given an option to leave
palette information out when saving a block.




TEXT

The Text icon allows you to add text to your pictures in a
variety of fonts, sizes, effects, orientations and colours.

Desk File Options

This is a Helvetica style font
This is a Times Roman style font

This is a Typewriter font
This is the System font

After selecting the text icon, simply move the pointer back
into the drawing area and start typing. You will find that the
text is printed in the current palette colour (unless a 'reverse’
writing mode is used) using the currently set attributes.
Furthermore, the text can be freely moved around the screen
following the mouse until the "Return’ key is pressed or the
left-hand mouse button is clicked. These two actions 'fix’ the
text string with all its attributes and they only differ in what
they permit you to do next:

The 'Return’ key fixes the current string of characters and
moves your print position onto the next line (not always the
line below, see ’Orientation’) and a column determined by
your chosen justification, e.g. if left justification is selected,
the implied text cursor is positioned exactly under the left-
most character of the fixed string just like a typewriter or a
word-processor. The text you type in now is no longer
moveable as its position has been set in relation to the
previous line.




TEXT

Clicking the left-hand mouse button, terminates and fixes the
string and allows you to start again with a new one at a
different position.

The various text options of the current string can be changed
‘on-the-fly’ provided that the string hasn’t been fixed yet.

Double-clicking on the text icon or selecting 'Text’ in the
"Options’ menu brings up the "'TEXT OPTIONS’ sub-menu
which lets you select the Font and Font size, the Orientation,
the Style and Justification and the Writing Mode.

Alternatively, the four keyboard short-cuts can be used to
produce the text dialog boxes directly - a very handy method
of changing parameters while you are still typing the text in.

FONT (At D

This option lets you select the Font (typeface) and the Font
size (in typographical points a la GEM!) to be used by the
current text string. Up to 9 fonts (including the system font
which is always there) and 9 popular point sizes are
supported.

Select Font and Size

6x6 systen
Swiss

9 paint
18 point
12 point
16 point
18 point
28 point

v 24 point
36 point

_____________ 48 point

Typewriter

The fonts are loaded when you first run the program (unless
you hold the Alternate key down while loading) and must
conform to the GDOS standard. Fonts may be installed or
removed using the procedure detailed in Appendix A.
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TEXT

The available font point sizes are: 9, 10, 12, 16, 18, 20,

24, 36 and 48. Selecting a font by clicking the left-hand
mouse button on its name, immediately shows which point
sizes that particular font supports. You simply click on the
size you want and this becomes the current size for all your
text handling until you select another size or another font.

ORIENTATION (Alt D)

The orientation or rotation of your text string describes the
direction of writing. There are four possibilities:

Select Orientation

[ Cancel BN 0K |
(6] Left to right (0 degrees anti-clockwise rotation)
(i)  Upwards (90 degrees anti-clockwise rotation)

(iii)  Right to left (180 degrees anti-clockwise rotation)
(iii) Downwards (270 degrees anti-clockwise rotation)

Desk File Options

Left to Right

mumo(  Upwards




TEXT

It is worth noting that left to right and right to left are NOT
mirror images of each other (nor are upwards and
downwards). Just imagine that you carry on writing in the
conventional manner but somebody keeps rotating your
paper from time to time by 90, 180 or 270 degrees
clockwise!

STYLE (Alt K)

This dialog box lets you select the special effect(s) you wish
your text to have as well as the way it is justified once fixed
by the 'Return’ key.

Select Text Effect

v Normal Left Justified
Bold v Centered
Italic Right Justified

Underlined
Outlined
Light

All GEM effects, supported by the ST implementation, are
offered:

Normal (cancels all others)
Bold

Italic

Underlined

Outlined

Light

The typed text can be Left, Centre or Right justified; that is,
on each Return key press, the text line can be aligned to the
left margin, can be centrally positioned or can be aligned to
the right margin.

You will, no doubt, find the best uses for justified text
through experimentation like, for example, the use of Right
justification when a piece of text has to be aligned to a right-
hand edge etc.
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WRITING MODE (Alt L)

Like the "Fill mode’, the text writing mode determines how
the string is 'blended’ with the existing picture. The same
modes (Replace, Transparent, Invert and Reverse
Transparent) apply and these are fully described in the
section on "Fill".




TEXT
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SHAPES

. To select this tool, click once on the Shapes icon; to choose a
Qﬁ particular type of shape to draw, double-click on the icon or
SHAPE click on ’Select Shape’ in the 'SHAPE OPTIONS’ sub-menu

e or simply use the ’Alternate A" keyboard shortcut.

Choose Shape

Lines Curves

Continuous Lines Rays

Triang'es Filled Triangles
Rectangles Squares
Filled Reclanéles Ellipses
Filled Squares Circles
Circular Arcs Filled Ellipses
Elliptical Arcs Filled Circles

Filled Circular Arc Filled Elliptical Arcs

Shapes are divided into two types: unfilled and filled.
Unfilled shapes are drawn using the current palette colour,
the current pen thickness and, for the minimum pen thickness
only, a line style normally set by the 'Set parameters’ (Alt C)
option in the 'SHAPE OPTIONS’ sub-menu. This is an
important point to remember because, no matter which line
style is selected, for lines thicker than 1 pixel GEM defaults
to a solid line.

Filled shapes use the current monochrome or colour fill
patiern and can be optionally outlined by a single-pixel line
in the current colour and line style. The option to outline is
also set using the “Set parameters’ (Alt C) entry of the
"SHAPE OPTIONS’ sub-menu.




SHAPES

All shapes operate in a 'free-movement’, 'rubber-band’
fashion in which the selected shape is dynamically generated
and drawn as the mouse is moved freely around without any
buttons being pressed; when a point or a radius or an angle
needs to be fixed, the left-hand mouse button is pressed and

the process either ends or enters its next construction’ phase.

For example:

To draw a curve, select the curves icon in the Shapes dialog
box and click on "OK’ or press Return. Then click the left-
hand mouse button once on the point on the canvas where
you want the curve to start.

The point is marked with an "X’ and as you move the mouse
freely around the canvas, a 'rubber band’, anchored at the
"X point, follows the tip of the pointer. The rubber-banded
line lets you set the steepness ('the tangent’) of your curve at
the point it takes off. Once you’ve chosen the tangent,
clicking the left-hand mouse button fixes it (although it is
removed from the screen for aesthetic reasons).

You then click the mouse button on a point on the canvas
where you want the curve to pass through. A new marker
appears and as you freely move the mouse again, a rubber-
banded tangent similar to the previous one follows the
pointer. In addition, the two "X markers are joined by a
curve of a fixed initial steepness and a shape controlled by
the mouse.

When you are happy with the curve, you fix the second
tangent by clicking the mouse button once, the markers are
erased and the curve joining the two points is printed in the
current colour and pen thickness.

The steepness of the second point of the curve is
‘remembered’ so that clicking on another point on the canvas

lets you chain segments of curves together in a continuous
manner.

Pressing the Escape key (ESC) at any time, terminates this
‘chaining’ and allows you to start a completely new curve.

Pressing UNDO has a similar effect but also erases all the
chained segments and restores the screen to its previous state.




SHAPES

You will soon work out how to use the Shapes provided you
remember that button clicks are only used to fix the various
parameters of the shape (vertices, angles etc) while "rubber-
banding’ is done by freely moving the mouse without
holding down the left-hand mouse button.

The parameters of a shape vary depending on the shape in
question. For example, a line is fully defined by fixing its
two end points while a circle needs a centre and a radius, an
ellipse needs a céntre and two radii etc.

To create arcs you need a centre, one or two radii, a starting
angle and an ending angle. The arc will be drawn from the
starting angle to the ending angle in an anti-clockwise
direction.

The procedure is as follows:

(6] Define the centre of the circle or the ellipse which
contains the arc by clicking the left-hand mouse
button once.

(i)  Move the mouse freely (without pressing any buttons)
to define the radius (or radii).

(iii)  Click the left-hand mouse button to fix it.

(iv) Move the mouse freely to define the starting angle of
the arc.

(v)  Click the left-hand mouse button to fix it.
(vi) Move the mouse until the desired arc is displayed.
(vil) Click the left-hand mouse button to fix it.

The continuous nature of rays, continuous lines and curves
necessitates the use of the Escape key as a means of
terminating the operation. You will find that while these
shapes are active, you can no longer switch from full to
windowed screen and vice versa or change workstation;
you’ll have to interrupt the operation first by pressing Escape
(or Undo, as described above).




SHAPES
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Z00M

ZOOM

To select zoom mode, click on the Zoom icon once. To set a
default magnification, double-click on the icon or select
'Zoom’ in the 'Options’ menu. One of four 'coarse’ levels of
magnification can then be selected (x2, x4, x8 and x16).

When the Zoom tool is selected, moving the pointer back
into the work area changes it to a magnifying glass. Position
the magnifying glass over the point that you want to become
the centre of the zoom rectangle and click the left-hand
mouse button once; the normal screen is replaced by the
"Magnify’ screen which consists of the following:

The 1:1 window, a rectangle containing a large chunk of
your canvas at its normal size. A dotted, rectangular outline
(the 'focus rectangle’) marks the exact section of the picture
that is being shown in the Edit Window.

The Edit Window occupies the largest part of the top right
area of the Magnify screen and consists of the contents of the
"focus rectangle’ magnified by the currently selected zoom
factor.




Z00M

This is where the editing of the magnified picture takes
place, by the user 'painting’ the ’fat-bits’ using the arrow
cursor and the current palette colour. The changes are shown
immediately on the part of the 1:1 window that is enclosed
by the focus rectangle.

The palette, where colours are selected as usual by clicking
on the appropriate box. Double-clicking to set the palette
colours 1s NOT permitted.

The bits'n’pieces, The arrows allow you to move the focus
rectangle over any part of the full screen picture.

The Plus (+) and Minus (-) signs increase and decrease the
magnification respectively in steps of 1 from a minimum of
x2 to a maximum of x16. The current zoom factor is shown
in the box between -’ and "+'.

"Exit’ (or the Return key) fixes the last changes and returns
to the previous screen mode.

"Undo’ has a toggling effect in Zoom mode: Pressed once, it
cancels the last change; pressed again, cancels the last 'undo’
and restores the last change and so on.
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KNIFE

4

KNIFE

The knife or Jack-Knife allows you to CUT irregularly-
shaped blocks. Once CUT, a block can be manipulated the
usual way by the various block operations.

Click on the Knife Icon to select it and then move back to
your painting area, click the left-hand mouse button at the
point where you want to start and then, without releasing the
button, 'trace’ the shape you want to cut out. When you let
go of the button, the block is stored in the Cut Buffer, the
Knife tool is automatically de-selected and the Block tool is
selected.

Desk File Options
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KNIFE
"Paste’ mode becomes the current block operation until
another is chosen. Just like cutting blocks, holding SHIFT
down while cutting with the knife leaves the cut section in its
place, otherwise it physically removes it.
¢ D:\PAINTAUNTITLED. PT
4
s
b
3 :
/74 © B
Double-clicking on the Knife icon brings up the BLOCK
OPTIONS sub-menu. Knife supports the same range of block
manipulation commands mentioned in section L.
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WELCOME TO ATARI GDOS
SYSTEM COMPONENTS
USING THIS GUIDE

GETTING STARTED
Making a working copy of the GDOS Distribution Disk

DISTRIBUTION DISK CONTENTS
INSTALL.PRG and INSTALL.RSC

GDOS.PRG

The META Folder

The HILO_RES and MED_RES Folders

The PRINTER Folder

README.DOC

THE INITIAL GDOS INSTALLATION
EFFECTS OF THE GDOS INSTALLATION
ASSIGN.SYS

The GDOS.SYS folder

GDOS FONT FILES

GDOS FONT FILENAMES

GDOS DEVICE DRIVERS

RUNNING A GDOS BASED PROGRAM
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Quit
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THE DEVICE MENU

Low, medium, and high resolution
Printer

Meta

THE OPTIONS MENU

Find Fonts

Find Driver

Remove Fonts and Remove Driver
Merge Fonts

THE INSTALL MENU

GDOS System Folder

New GDOS.PRG

New Drivers/Fonts

New ASSIGN.SYS

Loading your customised GDOS installation

GDOS ERROR MESSAGES
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WELCOME TO ATARI GDOS

Welcome to Atari GDOS, the program that enables the Atari ST and
MEGA computers to use graphics printing devices and custom fonts.

GDOS (Graphics Device Operating System) is installed in your System

with the GDOS installation program and enabled through GDOS-based

applications such as paint packages, drawing programs, word processors
and desktop publishing software.

With GDOS installed, you can use a selection of fonts in your picture and
you can print it as you see it to any GDOS-compatible printer such as the
Atari SMM804 dot-matrix printer and the Atari SLM804 laser printer.

Once installed, GDOS is loaded from your boot drive when you switch on
your system and remains resident in RAM throughout your work session.

GDOS and the GDOS installation program can be used with Atari MEGA
and ST computers, GDOS-compatible printers and GDOS-based
applications.

SYSTEM COMPONENTS

In order to customise GDOS, you must set up your Atari computer system
with the following components:

Atari MEGA or ST computer

Two Atari disk drives (may include one hard disk drive)
Atari Monitor or television

Atari GDOS-compatible printer

Formatted floppy disks

E I R

Set up your system following the instructions in the Owner’s Manuals
supplied with the equipment. Before using GDOS, it is recommended that
you have a good working knowledge of all components of your Atari
computer system.
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USING THIS GUIDE

The information and illustrations in this manual tell you how to install
GDOS in your system for the first time and then customise the installation
for your particular needs. For best results, it’s recommended that you work

through the manual from beginning to end. Once you’re familiar with using

the GDOS installation program, this manual can serve as a reference guide
to individual procedures and specific information.

A summary of each manual section follows:

Getting Started explains how to make a working copy of the GDOS
distribution disk and install GDOS for the first time. This section includes
descriptions of all information on the GDOS distribution disk.

Customising Your GDOS Installation explains how to use the
installation program to customise GDOS for your special needs. Most
importantly, this section includes directions for installing new fonts and
device drivers.

GDOS Error Messages explains the error messages your system may
return once the GDOS.PRG file is on your boot disk.

GETTING STARTED

Making a Working Copy of the Distribution Disk

The GDOS installation program is contained on the GDOS Distribution
Disk. It is essential that you make a working copy of the disk to use
routinely, and store the original disk as your backup copy. Doing this
protects you from losing the original disk or damaging its contents.

Write-protect the original disk by-sliding its write-protect tab so you can
see through the notch. (When a disk is write-protected, its information
cannot be changed or erased). Then copy the disk from the desktop,
following the instructions in your Atari computer Owner's Manual. If you
have a hard disk connected to your system, copy the GDOS Distribution
Disk to the root directory of drive C.

Always use the copy as your working disk. Store the original disk in a safe
place protected from dust, moisture, direct sunlight, and sources of electric
power or magnetism. If the information on your working disk is damaged
or erased, use your original disk to make a new working disk.
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GDOS DISTRIBUTION DISK CONTENTS

The GDOS distribution disk contains the files you need to install GDOS in
your system. The files include several device drivers and fonts. Device
drivers allow GDOS to print or display to a particular graphics device;
fonts tell GDOS the form of the characters to be printed or displayed.

To see what the disk contains, display a directory window for it on the
desktop. The directory looks like this:

i o o e R

HILO_RES MED_RES PRINTER GDOS .PRG INSTALL.PRG  INSTALL.RSC

¢[ [o]R

INSTALL.PRG and INSTALL.RSC

INSTALL.PRG is the GDOS installation program, which lets you install
the GDOS program, fonts, and device drivers from the GDOS Distribution
Disk into your system. After the initial GDOS installation, you will use
INSTALL.PRG to install new fonts and device drivers or remove those
already resident, as your needs change.

INSTALL.RSC is the GDOS installation program’s GEM resource file.

In order to run, INSTALL.PRG must be in the root directory of a

disk in drive B or in the root directory of drive C, and INSTALL.RSC must
be in the same directory. (For complete information, see The Initial
GDOS Installation later in this section).

GDOS.PRG

GDOS.PRG is the GDOS program. During the initial GDOS installation,
GDOS.PRG is written to an AUTO folder on your boot disk (drive A or
drive C). This allows your system to run GDOS.PRG automatically during
booting. (For complete information, see The Initial GDOS Installation
later in this section).
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The HILO_RES and MED_RES Folders

The HILO_RES and MED_RES folders contain the GDOS fonts for high-
, low-, and medium resolution screen display. Screen fonts are the
counterpart of printer and meta fonts, and are used by GDOS to display on
screen exactly how a document or picture will look when printed.

Screen fonts for high and low resolution are identified by short filenames
(six characters plus an extension); screen fonts for medium resolution are
identified by having 'CG’ as the seventh and eighth characters in the
filename.

Screen fonts are run by the screen driver SCREEN.SYS, which is resident
in ROM.

The META Folder

The META folder normally contains metafile fonts, should an application
require them. An image orientated program such as HyperPaint does not
require access to Metafile fonts.

The PRINTER Folder

The PRINTER folder contains GDOS device drivers for the Atari

SMM804 dot-matrix printer, the Atari SLM804 laser printer, the Star
Micronics NB15 and the Epson FX-80 dot-matrix printer. The printer

drivers are identified by the printer name followed by the extension ".SYS’

e.g. FX80.SYS.

README.DOC

If README.DOC is present on your disk, be sure to read it before using
the GDOS installation program. README.DOC will explain any
production changes made to the GDOS distribution disk that are not
described in this manual. (You can read the file either by printing it to the
screen or by opening it within a word-processing application such as
Microsoft Write or 1st Word Plus).
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THE INITIAL GDOS INSTALLATION

When you run the GDOS installation program for the first time, you will
accomplish three things:

(6)) GDOS.PRG will be installed in an AUTO folder on your boot disk.

(i) An ASSIGN.SYS file will be written to the root directory of your
boot disk. ASSIGN.SYS provides the roadmap for the GDOS
program, telling it which device drivers and fonts are used together
and where to find them in the system.

(iii) A GDOS system folder (GDOS.SYS) will be written to the drive
you specify. The folder will hold all device drivers and fonts
supplied on the distribution disk. Later any drivers and fonts you
install for other devices will be added to the folder.

To run the GDOS installation program you must have at least two disk
drives connected to your system. The second drive will be either a floppy
or hard disk drive.

To run the GDOS installation for the first time, follow these steps:

6)) With the desktop displayed, insert your working GDOS distribution
disk into the drive as described in paragraph A or B:

(A) If you have two floppy disk drives, insert your working
GDOS distribution disk into drive B. Insert your boot disk
(the disk containing your desk accessories) into drive A. If
you don't have a boot disk, insert a blank, formatted disk
into drive A. Then go on to step (i1).

(B) If you have a hard disk drive, copy the GDOS distribution
disk to the root directory of drive C. (You may have done
this already when you made a working copy of the
distribution disk). If your system boots from the hard drive,
go on to step (ii). If your system boots from a floppy drive,
insert your boot disk (the disk containing the AUTO folder
and any desk accessories) into drive A, then go on to step
(in).
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(i)  Display a directory (either B or C) for your GDOS Distribution
Disk and double-click on INSTALL.PRG. In a moment, the
INSTALL.PRG desktop and a dialog box appear:

/M File Device Options Install

6D0S Installation Program

Please select your boot drive.
If a floppy drive is selected,

place your boot disk or a newly
formatted disk in drive A.

I e )

(iii)  In the dialog box, select Floppy or Hard Disk to specify your current
boot drive. Then select OK. A dialog box appears:

First Time GDOS Installation

GDO0S ‘was not found on your boot
disk. Select "Ok" to install the
GDOS Distribution disk.

[«]  [owen]
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(iv)

(v)

(vi)

Select OK to continue with the GDOS installation. A dialog box
appears:

GDOS System Folder

Please select the drive where
the GDOS System Folder will be
placed for use by 5DOS.

In this dialog box you specify the drive where the GDOS program
will find the GDOS system folder. The GDOS system folder
contains the device driver and fonts needed by your GDOS-based
applications. You must specify the drive now so that
INSTALL.PRG can record that location in the ASSIGN.SYS file it
will soon create.

You can select any drive available in your system. (Non-available
drives are shadowed in the dialog box). To help you decide which
drive to specify, remember that when you later run a GDOS-based
application such as HyperPaint, the disk containing the GDOS
system folder must remain in the drive you choose now. For
example, if you have two floppy drives and you are going to run
HyperPaint from drive A, you should select drive B for your GDOS
system folder. If you have a hard disk drive, it is highly
recommended that you specify an available hard disk partition.

Select your drive, then select OK.
A. If you specified a floppy drive in step (v), a.dialog box

appears asking you to insert a blank, formatted disk into
drive A.

Please place a newly formatted
disk or your GDOS System
Folder disk into drive A.

o]
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Insert the disk into drive A, then select OK. The GDOS.SYS
folder is created on that disk, which you will later keep in
whatever drive you specified in step (v) whenever you run a
GDOS-based application.

B. If you specified a hard disk partition in step (v), the
GDOS.SYS folder is now created there.

Dialog boxes monitor the operation.

(vii)  If your system boots from a floppy drive, a dialog box now asks you
to insert your boot disk into drive A. Do that, then select OK. (If
your system boots from a hard drive, this message is not displayed).

Please place your boot disk
into drive A,

Cac]

The program now writes GDOS.PRG to an AUTO folder on your
boot disk. If an AUTO folder exists on your boot disk, GDOS.PRG
is added to it. Then the program creates the ASSIGN.SYS file in the
root directory of your boot disk. Dialog boxes monitor these
operations.

(viii) GDOS is now installed, but you must reboot your'system in order to
load it. A dialog box appears:

SYSTEM REBOOT

You must reboot the
system to install GDOS

or any new changes.

Select Reboot. While the system reboots, GDOS loads automatically

from the AUTO folder and a message appears telling you that
GDOS is resident.

Then the desktop appears.
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EFFECTS OF THE GDOS INSTALLATION

Now that you’ve installed the GDOS program, device drivers, and fonts
supplied on the GDOS Distribution Disk, your system can display those
fonts on screen and print them to a supported printer.

Note: GDOS printer drivers are available for other printers in
addition to the ones mentioned previously. For information contact your
Atari Dealer or see Customer Support at the end of this manual.

Installing GDOS results in the following new folders and files on
your system:

*  The GDOS program GDOS.PRG was copied from the GDOS
Distribution Disk to an AUTO folder on your boot disk (floppy or
hard).

*  An ASSIGN.SYS file was written to your boot disk.

* A GDOS system folder named GDOS.SYS was created on disk for use
in the drive you specified. Once the folder was created, the GDOS
installation program read all the device drivers and fonts from the
folders on the distribution disk into GDOS.PRG for later use with your
GDOS-based applications.

ASSIGN.SYS

The ASSIGN.SYS file is a text file that records the location of the GDOS
files and folders in your system. It works as a roadmap for the GDOS
program, telling it what device drivers and fonts are used together, and
where to find them. Information in ASSIGN.SYS is read into RAM during
booting, and remains resident until you reboot or switch off your system.

As you install and remove drivers and fonts, you will write updated
ASSIGN.SYS files to your boot disk. A valid ASSIGN.SYS file must be
current in order for GDOS to locate installed device drivers and fonts.

Note: the ASSIGN.SYS file contains filenames only. The actual font and
device driver files are contained in the GDOS.SYS folder.
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The GDOS.SYS Folder

The GDOS.SYS folder contains the GDOS fonts and device drivers that
were supplied in the folders on your GDOS Distribution Disk. (The screen
driver SCREEN.SYS, which is resident in ROM, is not contained in
GDOS.SYS).

It’s recommended that you keep only those drivers and fonts you are
currently using in your GDOS.SYS folder, and remove all others. (See the
section on removing items from your GDOS installation). Keeping unused
items in your GDOS.SYS folder takes up disk space that you would
probably rather be able to use for something else.

GDOS FONT FILES

The GDOS font files contain the information GDOS needs to print and
display characters in various fonts to specific devices. A font is the size and
style of the characters in which text is displayed or printed.

Note: GDOS is compatible with all GEM-format fonts.

The fonts supplied on the GDOS Distribution Disk contain three typefaces:
Swiss, Dutch, and Typewriter.

Swiss and Dutch have 10-, 12-, 18- and 24-point fonts. (Points indicate the
size of a font; higher point sizes mean larger fonts). Swiss and Dutch are
also proportional fonts (that is, characters are proportionately wider or
narrower depending on their shape).

Typewriter is a 10-pitch fixed font; that is, it prints 10 characters to the
inch. (In a fixed-pitch font, all characters are the same width regardless of
their shape).

This is Swiss 10-point, a proportional font.

This is Typewriter, a 10-pitch fixed font.

This is Dutch 18-point, a proportional font

When using a GDOS-based application such as HyperPaint, you are able to
use a range of fonts on the same diagram or picture. To display these fonts
on screen, the GDOS program will use high, medium or low resolution
screen fonts depending on the resolution HyperPaint is being run in.
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GDOS FONT FILENAMES

In GDOS, font files are named according to the following pattern:

ATcc#¥#nn.FNT

Where:

AT is the font file prefix (1)
cc is the font typeface (2)
i is the font size (3)

nn is the font device (4)

.FNT is the font file extension (5)

For example:

(N
2)

3)

4)

(5)

Note:

ATTRI12MF.FNT is a Dutch 12-point font for metafiles
ATSS12.FNT is a Swiss 12-point font for high and low resolution

All font filenames begin with "AT" as the first and second letters.

The third and fourth letters of the font filename identify the
typeface: "SS" for Swiss; "TR" for Dutch; and "TP" for Typewriter.

The fifth and sixth characters of the filename indicate the point size
of the font; 10-, 12-, 18-, or 24-point.

The seventh and eighth characters of the filename identify the
device the font is designed for: "LB" means Atari SMM804 dot-
matrix printer; "LS" means Atari SLM804 laser printer; "EP" means
the Epson FX-80 printer; "SP" means the Star NB15 printer; "MF"
means metafile; "CG" means colour graphics medium-resolution
screen; no seventh or eighth character means high- and low-
resolution screen fonts.

All font files end with the extension ".FNT".

See the README.DOC file, if present on your GDOS Distribution
Disk, for any modifications to the pattern of font filenames.
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GDOS DEVICE DRIVERS

The GDOS device drivers contain the routines GDOS needs in order to

print or display to a particular graphics device (such as the screen, a printer,

a plotter, or a camera). Each graphics device must have its own GDOS
device driver and (where required) fonts installed in the system in order to
display or print GDOS images.

Device driver filenames include the name of the device and the extension
".SYS". For example, the file FX80.SYS supplied on your GDOS
Distribution Disk 1s the device driver for the Epson FX-80 dot-matrix
printer.

RUNNING A GDOS-BASED PROGRAM

With GDOS installed, you can run any GDOS-based application and
display and print documents or images incorporating GDOS fonts. While
you're running the application, the GDOS system folder must remain in the
drive you specified during GDOS installation. This allows the application
to use the drivers and fonts in the GDOS system folder. Refer to the first
part of the HyperPaint manual for more information on using GDOS within
the application.

CUSTOMISING YOUR GDOS
INSTALLATION

INSTALL.PRG on the GDOS Distribution Disk is the program you use to
install GDOS in your system. Once GDOS is installed, you can use
INSTALL.PRG again and again to add new device drivers and fonts to the
GDOS system folder and remove those you don’t need. After you add or
remove fonts, INSTALL.PRG writes your new GDOS installation to disk
and updates the ASSIGN.SYS file.
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To customise your GDOS installation, begin by running INSTALL.PRG
from the directory of your GDOS Distribution Disk (in drive B or on your
hard disk drive). In a moment, the INSTALL.PRG desktop appears, along
with a dialog box: '

G6D0S Installation Program

Please select your boot drive.
If a floppy drive is selected,
place your boot disk or a newly
formatted disk in drive A,

[Hard pisk] | o |

The program is asking to be directed to your boot drive so it can read the
ASSIGN.SYS file. Select either Floppy or Hard Disk depending on your.
boot drive, then select OK. After the program reads ASSIGN.SYS, the
INSTALL.PRG menu bar is displayed:

/N File Device Options Install

The program'’s five menu-bar headings, Atari, File, Device, Options, and
Install, include drop-down menus containing the options you’ll use to
customise your GDOS installation. Move the mouse pointer to a heading
and display its menu.
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THE ATARI MENU

The ATARI menu contains the GDOS Info... option, plus any desk
accessories loaded during booting. The desk accessories will be unavailable
while you are working with the GDOS installation program.

M File Device Options Install
6D0S Info...

Y152 Enulator

Cantrol Panel

Set RS232 Canfig.

Install Printer

GDOS Info...

When you select GDOS Info..., a dialog box appears:

6D0S Installation Program
By Mike Schmal
Version 1.8

Copyright 1987 Atari Corporation

A ] A

Select Exit to quit the option.
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THE FILE MENU
The File menu contains the Quit option.

/N IEIEN Device Options Install

Quit
Select Quit to exit the installation program and return to the GEM Desktop.

If you have made no changes to your GDOS installation, the program
closes and GEM Desktop appears.

If you made changes to your GDOS installation, but did not select any
options from the Install menu, a dialog box tells you the installation will be
cancelled.

WARNING
Installation Canceled!

Select "Ok" to cancel this
6DOS installation!

Select OK to cancel any changes and return to GEM Desktop; select Exit to
retain the INSTALL.PRG menu bar on screen and continue with the
installation.
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If you made changes but didn’t complete the installation by selecting the
correct options from the Install menu, or if you deleted a file from the
Install window, a dialog box tells you that the installation is incomplete.

WARNING
Installation Incomplete!

Use the INSTALL menu to
complete the installation.

Select OK, then complete your installation by selecting the correct options
from the Install menu. (See the Install Menu later in this section).

If you made changes and completed the installation with options from the
Install menu, a dialog box gives you the choice of rebooting or canceling.

SYSTEM REBOOT

You must reboot the
system to install G6DOS

or any new changes.

e S .

Select Reboot so that your system will load your new GDOS installation
before returning to GEM Desktop.

Select Cancel to return to GEM Desktop without loading your new
installation. The new installation is retained but you must reboot in order to
use it.
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THE DEVICE MENU

Each graphics device must have its own GDOS device driver and, where
applicable, fonts installed in order to display or print GDOS images. The
Device menu lists several graphics devices.

/M File [PITHTN Options Install
Low Resolution
Medium Resolution
High Resolution

Printer
H

eta

When you select a device from the menu, two windows open on screen:

/M File Device Options Install

fAvailable

Printer Driver® SMM884,SYS
Fonts

Printer

@
ATSS1BLB.FNT ATSS1ZLB.FNT ATSSLBLB.FNT ATSS24LB.FNT
ATSS1BLB. FNT ATTPLBLB.FNT ATTRIBLB.FNT ATTRLZLB.FNT ATTRiBLB.FNT
ATSS12LB FNT ATTRZ4LB.FNT
ATSS18LB.FNT
ATSS24LB.FNT
ATTP1BLB.FNT
ATTR1BLB.FNT
ATTRLZLB.FNT
ATTR18LB.FNT

>

SIL

The Available window, on the left, shows the fonts available on your
Distribution Disk (either in drive B or on drive C) for the selected device.
The Installed window, on the right, lists all currently installed fonts for the
selected device (the name of the device appears at top centre of the
window). Fonts are installed when they are contained in the GDOS.SYS
folder.
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Using the Available and Installed windows, you can install new fonts or
remove those you don't need. Install fonts by selecting their filenames in
the Available window and dragging them to the Installed window. Remove
fonts by selecting their filenames in the Installed window and dragging
them to the trash can.

Note: You can select filenames by either clicking on them with the left-
hand mouse button or using a rubber-band box. Once filenames are
selected, you can deselect them by clicking on them again with the left-
hand mouse button. To deselect all selected filenames in a window, click
the right-hand mouse button within the window.

To install and remove device drivers, use the Find Driver and Remove
Driver options in the Options menu. (See Find Driver and Remove
Fonts and Remove Driver later in this section).

Low, Medium and High Resolution

The screen display is a graphics device that "prints" (displays) graphics
output. Characters and shapes on screen are actually groups of pixels
(picture elements) arranged to form images according to a design (the
screen font). Each screen resolution is a separate graphics device using its
own pixel size.

A screen device driver (SCREEN.SYS) and system screen fonts are already
resident in ROM. The GDOS Distribution Disk contains additional screen
fonts for high, low, and medium resolutions. These screen fonts are used by
GDOS to display on screen exactly how a picture or diagram will look
when printed. The screen fonts are installed during your initial GDOS
installation.

Select the Low, Medium, or High Resolution option to remove the installed
screen fonts or reinstall them later.

Note: High and Low screen resolutions use the same fonts. When you try
to remove fonts for either resolution, INSTALL.PRG first checks whether
the fonts are used by another driver in the system. If so, the fonts are not
erased.

Printer

Each printer has its own GDOS device driver and fonts. Because
HyperPaint simply sends a complete bit-image to the printer, it does not
insist on printer fonts being installed. However, other GDOS-based
applications such as Microsoft Write, HyperChart or HyperDraw will
require the installation of printer fonts.
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The GDOS Distribution Disk contains device drivers for four popular
printers; the Atari SMM804, Atari SLM804, Star Micronics NB15 and the
Epson FX-80, one of these will be installed during your initial GDOS
installation. GDOS Drivers and fonts for other printers are continually
being made available, for more information contact your Atari dealer or see
Customer Support at the end of this manual.

Select the printer option to install or remove printer fonts and device
drivers.

Meta

A metafile is an "ideal" data file that can be used with any graphics device.
Metafiles are used by applications to contain, for example, a document’s
text and a complete description of how it looks when printed. HyperPaint
does not require that metafile fonts are present. However, as with printer
fonts, other applications may require the installation of the metafile driver
and fonts.

THE OPTIONS MENU

When you select something from the Device menu, the Options menu
selections are activated.

/M File Device NTIITIEN Install
Find Fonts,,,
Find Driver,,,
Renave Fants,,,
Renave Dri y

Find Fonts

Use the find fonts option to locate fonts in your system that are not on the
GDOS Distribution Disk. First, insert a disk containing the new fonts that
you want to install into a drive. (If you have two floppy drives, insert the
the disk into drive B). Then display the Available and Installed windows
for the device those fonts will be used with (see The Device Menu earlier
in this section).
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Next; select the Find Fonts option to locate the new fonts. The GEM item
selector appears:

ITEM SELECTOR

Directory:
C:\PRINTER\¥*, FNT

ATSS1BLB.FNT 7
ATSS12LB.FNT F——
ATSS18LB.FNT
ATSS24LB.FNT
ATTPL6LB.FNT

ATTR1BLB.FNT
K

ATTR12LB.FNT
ATTR1BLB.FNT
ATTRZ4LB.FNT

The item selector's directory line shows the drive that you ran
INSTALL.PRG from, the folder on that drive containing fonts from your
selected device, and the .FNT (font) extension. Click on the directory line
to move the cursor there, then edit the line to show the path to the new
fonts. Update the item selector’s window by clicking on the scroll bar. The
filenames of the new fonts will appear in the window.

Next, select OK to make these fonts available for installation. They now
appear in the Available window.

Note: When adding new fonts from more than one floppy disk, you must
complete the installation of fonts from one disk (with the New
Drivers/Fonts option from the Install menu), before going on to install fonts
from another disk.

Find Driver

Use the Find Driver option to locate device drivers in your system that are
not on the GDOS Distribution Disk. First, insert a disk containing the new
device driver that you want to install into a drive in your system. (If you
have two floppy drives, insert the disk into drive B). Then select a device
from the Device Menu (see The Device Menu earlier in this section). The
Available and Installed windows for that device will appear.
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Next, select the Find Driver option to locate the new driver. The GEM item
selector appears:

ITEM SELECTOR

Directory!
C:\PRINTER\#*,SYS.

The item selector’s directory line shows the drive you ran INSTALL.PRG
from, the folder on that drive containing a driver for your selected device,
and the .SYS (driver) extension. Click on the directory line to move the
cursor there, then edit the line to show the path to the new driver. Update
the item selector’s window by clicking on the scroll bar. The filename of
the new driver will appear in the window.

Double-click on the new driver’s filename to select it for installation. The
driver’s filename now appears at the top left of the Installed window.

Note: When adding new drivers from more than one floppy disk, you must
complete the installation of a driver from one disk (with the New
Drivers/Fonts option from the Install menu), before going on to install a
driver from another disk.
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Remove Fonts and Remove Driver

You can remove installed fonts and drivers. With the Available and
Installed windows for a particular device on screen, select either the
Remove Fonts or Remove Driver option. A dialog box appears:

REMOVE
Printer
Fonts?

v _Remove Files?

If the Remove Files Box is ticked, the program will erase the currently
installed fonts or driver from the GDOS.SYS folder. If the box is not
ticked, the program will only remove the installation record of the fonts or
driver from the ASSIGN.SYS file. The removed fonts or driver will remain
in the GDOS.SYS folder, but will not be used.

Click on the Remove box to toggle between ticked and not ticked. Then
select OK to remove the fonts or driver (or Cancel to cancel the operation).

Note: High and low screen resolutions use the same fonts. If you try to
remove fonts for either resolution, INSTALL.PRG first checks whether
those fonts are used by another driver in the system. If so, the fonts are not
removed.

Merge Fonts

With the Available and Installed windows for a particular device on screen,
select the Merge fonts option to merge all fonts in the Available window
with the fonts in the Installed window.
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THE INSTALL MENU

You must write your customised GDOS installation to disk in order to use
it. To do that, use the options in the Install menu.

/N File Device Options BUEREIN
Gdos System Folder
New GDOS.PRG
Hew Drivers/Fonts
Hew ASSIGH,SYS

GDOS System Folder

The GDOS system folder GDOS.SYS is the holding area for the installed
GDOS device drivers and fonts. The folder was created during the initial
GDOS installation and resides on the drive you specified at that time. You
can use the GDOS System Folder option to relocate the folder to the root
directory of any other drive on your system.

Warning: After you relocate GDOS.SYS to another drive, you must
reinstall all device drivers and fonts.

To relocate the folder, select GDOS System Folder from the Install menu.
A dialog box appears:

GD0S System Folder

Please select the drive where
the 6DOS System Folder will be
placed for use by GDOS.
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The drive where the folder currently resides is highlighted in the dialog
box. Select the drive where you want to relocate the folder, then select OK.
A dialog box appears reminding you that relocating the folder means
installing all drivers and fonts. Select OK to relocate the folder: select Exit
to discontinue the operation and return to the INSTALL.PRG desktop.

Once you've relocated the folder, use the Device and Options menus to
reinstall your drivers and fonts.

Reminder: The GDOS system folder must remain on a disk in the
currently specified drive at all times when you're running a GDOS-based
application.

New GDOS.PRG

The New GDOS.PRG option is used to write a new copy of GDOS.PRG to
the AUTO folder of your boot disk. You will need to do this if your
GDOS.PRG file is damaged, you received a new version of GDOS.PRG, or
you are installing GDOS.PRG on a new boot disk.

Insert the disk containing the correct GDOS.PRG into a floppy drive on
your system. Then select the New GDOS.PRG option, the GEM item
selector appears:

ITEM SELECTOR

Directory:
AI\E ¥

Elettiun:

@ HILO_RES..__

& MED_RES...__ ('_
BHETR ..o

@ PRINTER..._.
6DOS PRG
INSTALL .PRG
INSTALL .RSC

____________

o]
|| [Cancel ]

Use the item selector to locate the GDOS program on the floppy disk. Click
on the directory line to move the cursor there, then edit the line to show the
path to the program. Update the window by clicking in the scroll bar. The
filename GDOS.PRG will appear in the window. Double-click on the
filename to write the new GDOS.PRG to the AUTO folder on your boot
drive, where it replaces the old GDOS.PRG.
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New Drivers/Fonts

When you’ ve added new drivers or fonts to your GDOS installation, you
must use the New Drivers/Fonts option in order to complete the
installation.

If you have two floppy drives, the disk containing the new driver or
fonts should be in drive B. Insert your GDOS.SYS folder disk into drive A.
Then select New Drivers/Fonts. INSTALL.PRG writes the new fonts and
driver to the GDOS.SYS folder.

Note: Your GDOS.SYS folder disk must have enough space available to
accept the new fonts and drivers. If it doesn'’t, a dialog box appears telling
you so. Exit from INSTALL.PRG, and remove some files from the disk
before beginning to customise the GDOS installation again. Or, use a
blank, formatted disk in drive A when you use the New Drivers/Fonts

option.

If you have a hard drive, make sure the disk containing the driver or
fonts to be installed is in a drive in your system. Then select New
Drivers/Fonts. INSTALL.PRG writes the new fonts and driver to the
GDOS.SYS folder.

New ASSIGN.SYS

After making changes to your GDOS Installation, select the New
ASSIGN.SYS option to write a new ASSIGN.SYS file to the root directory
of your boot disk. Using the new ASSIGN.SYS option is required in order
to complete your customised GDOS installation, regardless of how minor
or major the changes were.

Loading Your Customised GDOS Installation

You must reboot your system in order to load your customised GDOS
installation. Select Quit from the File menu, then select reboot from the
dialog box that appears. Your system will reboot and load the new GDOS
installation. (For more information, see Quit earlier in this section).

After finishing your work session and switching off your system, your
customised GDOS installation will remain on disk. The next time you
switch on your system, the customised GDOS installation will load
automatically.

Reminder: When running a GDOS-based application, the GDOS.SYS
folder must be in the drive you specified during your GDOS installation.
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GDOS ERROR MESSAGES

When you switch on your system with GDOS installed, your screen may
display a GDOS error message. This section lists the messages you may see
and explains how to remedy the errors.

Illegal workstation ID in ASSIGN.SYS file

Partial record found in ASSIGN.SYS file

Drive specification not allowed in ASSIGN.SYS file
Invalid filename found in ASSIGN.SYS file
Attempt to read ASSIGN.SYS failed

These messages indicate an invalid entry or a corruption in the
ASSIGN.SYS file. Erase the GDOS.SYS folder from your system, and
ASSIGN.SYS and GDOS.PRG from your boot disk. Then reinstall GDOS
following the steps at the start of this Appendix.

Insufficient memory

Your system does not have enough memory to install GDOS. Free some
memory (for instance by disabling desk accessories), then reboot.

Corrupt driver file

A printer or meta driver in the GDOS.SYS file is corrupt. Copy an
uncorrupted file to the folder and reboot.

Atari GDOS release 1.1 not installed

This message appears if the GDOS installation program cannot install

GDOS. See the previous messages for possible reasons why GDOS failed
to install.
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HYPERPAINT PRINT UTILITY

INTRODUCTION

o
)

THE DESK MENU
About PaintPrt
Desk Accessories

AR X

THE FILE MENU
New

Open

Load options

Save options

Print

Quit

THE OPTIONS MENU
Picture type
Print options
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INTRODUCTION

HyperPaint’s printing utility PAINT.PRT is invoked by using the program’s

OUTPUT option.

Clicking on OUTPUT leaves HyperPaint and executes the printing utility. The
name of the file that you are currently editing is automatically passed to this
utility. A new menu bar appears together with an information box at the bottom
left-hand corner of the screen. If a filename has been passed to the printing utility
by HyperPaint, the picture file is loaded into memory and is then ready for
processing prior to printing; otherwise, an error message is displayed allowing you

to load a different image.

THE DESK MENU

About PaintPrt

UT52 Emulator
Control Panel
Set RS232 Config.
Install Printer

About PaintPrt

Selecting this item invokes an alert box
containing information such as the
program name, a copyright notice, the
author’s name etc.

Desk Accessories

GEM allows up to six desk accessories to
be installed at boot-up time; if you have
installed any, their names will appear in
this menu.
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THE FILE MENU

Load options
Save options

Quit

Load options
Save options

Quit

Quit

New

Selecting this option clears the current
picture in memory in preparation for a new
image to be loaded.

Open

Open invokes the standard GEM file
selector, enabling the user to select a new
image ready for printing.

Open automatically inserts the correct
extender for the filetype selected using the
Picture type option in the Options menu.
If you wish to load a different filetype,
simply replace the current filename
extender with one of your choice.

Load Options
This option loads the file: PAINT.OPT

This contains the default picture type and
print option settings. Invoking Load
Options overwrites any changes made
using the Options Menu.
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Load options
Save options

New
Open..
Load options
Save options

Save Options

Save Options writes the current picture
type and print options to the file:
PAINT.OPT. This allows you to customise
the HyperPaint print utility to suit the type
of pictures that you most frequently print.
Note that Save Options overwrites the
existing PAINT.OPT file, therefore ensure
that you have made backups of your
HyperPaint program diskette before using
this option.

Print

The print option processes and prints the
current image file using the current scaling
and positioning settings. If a colour picture
is output to a monochrome printer, patterns
of dots in differing densities are
automatically associated with the colours
contained in the picture giving a shading or
toning effect.

GDOS only permits the user to interrupt
the printing process at the end of a page by
taking your printer off-line, it may,
therefore, be a short while before printing
stops.

Quit

The Quit option normally exits from the
Print utility program and returns directly to
HyperPaint. Any settings made during the
current printing session will be lost unless
Save Options was used prior to Quitting.

If the Alternate key is held down whilst the
Quit option is selected, the HyperPaint
Printing utility returns difectly to the GEM
Desktop, rather than to the Paint program.
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THE OPTIONS MENU

Options
Picture type
Print options

Options

Print options

Picture type

Selecting the Picture type option invokes a dialog
displaying the four picture file formats currently
supported by HyperPaint. Clicking on any of the
file types automatically selects that filetype as the
default.

Select picture type

Note: The HyperPaint rint utility does not
currently support the printing or display of GEM
files, this option is, therefore, permanently
disabled (shadowed).

Print Options

Selecting Print Options invokes a dialog that
allows the user to specify where on the page his
image is printed and how the image is scaled.
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Set print options

Best fit scales the image being printed to fill the
entire page.

Off disables both horizontal and vertical scaling.
Off is ideal for printing 300 DPI scanned images
to the Atari laser printer.

X only disables vertical scaling and only scales
the width of the image to retain the proportions of
the picture. This feature allows very high density
prints on dot-matrix printers.

Y only disables horizontal scaling and only scales
the height of the image to retain the proportions of
the picture. This feature allows very high density
prints on dot-matrix printers.

Initial/final form feed allow the user to specify
whether form feeds are required before and/or
after every page printed.

Horizontal and vertical positioning allows
the image to be justified to any edge of the page
or positioned centrally.

No. of copies allows the user to choose how
many copies are printed of each page (upto 99).
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HYPERPAINT KEYBOARD SHORTCUTS

ALTERNATE

Pressing Alternate in conjunction with and alpha key (A-Z) effects a menu
shortcut according to the following table:

Y, Wz i ot e S Select Shape
Select Brush
Set Shape options

Do e T T Clear Screen

| L SR Workstation Manager

Fooceceeccceienne Select Mono Fill pattern

{2 R I TR Select Colour Fill pattern

Hoocc, Set Fill writing-mode
....................................... Select font and point size

.............................. Text orientation
..................................... Text style

...................................... Text writing mode

Mol o s el nsine) Cut

Flip horizontal
...................................... Flip vertical
...................................... Skew horizontal
Skew vertical

b AP LR R Start colour cycling
T iocnonsanmisSoiusmonsossoinsl Set colour cycling

If the Alternate key is held down while the program is loading, the fonts specified
in the ASSIGN.SYS file are NOT loaded.
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If left or right animation of workstations is in progress, pressing the Alternate key
stops the sequence.

Pressing Alternate before selecting REVIEW on the SET PALETTE dialog,
returns the colour under the cursor and selects it.

Pressing Alternate while quitting from the HyperPaint Print utility forces an exit to
the GEM Desktop, rather than returning to the paint program.

SHIFT

If either SHIFT key is held down while a block is being cut, the block is not
physically removed from the picture, but is merely copied into the CUT buffer.

If left or right animation of Workstations is in progress, pressing the left-hand
SHIFT key slows down the speed of animation, while the right-hand SHIFT key
increases it.

CONTROL

The CONTROL key is only used in text mode in conjunction with other keys to
produce part of the Atari extended character set.

ESCAPE

The ESCAPE key is used to interrupt continuous shapes such as Continuous Lines.
Rays and Curves or any shape which is in a rubber-banding mode. This key is also
used to exit from other functions such as Paste, Rotate, Flip horizontal and
vertical, Skew horizontal and vertical before their final position has been
determined.

THE FUNCTION KEYS

The function keys F1 to F10 are used to select a workstation. The number of
available workstations can be found via the Alternate E shortcut.

LEFT AND RIGHT CURSOR KEYS

The left and right cursor keys are used to initiate left and right animation of the
HyperPaint Workstations. The speed of animation is controlled by means of the
left and right SHIFT keys.

S-2



APPENDIX C: HYPERPAINT KEYBOARD SHORTCUTS

UNDO

The UNDO key cancels the last operation and restores the screen to its
immediately previous state. In the Zoom mode, UNDO has a toggling effect in that
it can undo its previous state.

HELP

The HELP key (as well as the right-hand mouse button) toggles the screen from
Window to full-screen mode and back.

Pressing any key while in the process of outlining or smoothing a block,
aborts the operation. Testing for a keypress is done every sixteen lines so as
not to slow down these operations and, therefore, the effect might not be
immediate.
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APPENDIX D

HYPERPAINT PICTURE FORMATS

HyperPaint supports some of the most popular picture file formats:

NEOchrome (.NEO)

Degas Normal (.P11, .PI12, .PI3)
Degas compressed (.PC1, .PC2,.PC3)
DRI bit image (.IMG)

NEOCHROME FILE FORMAT

NEO files are usable in Low Resolution only. The length of a typical NEO picture
file is 32128 bytes made up of a 128-byte Header followed by 32000 bytes of raw
picture information in the ST's interleaved plane format.

The Header format is as follows:

Byte offset Length Explanation

+0 1 WORD 0

+2 1 WORD 0

+4 16 WORDS Hardware Colour Palette.

+48 1 WORD If bit 15 is set, the low 8 bits are valid.Then:

High Nibble= start ink in cycle (0-15).
Low Nibble= end ink in cycle (0-15).

+50 1 WORD If bit 15 is set, the low 8 bits are valid. Then~
Low 8 bits=Cycle speed and direction
(signed number, negative = left).

+52 to +128 Not used.
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DEGAS NORMAL FILE FORMAT

The DEGAS Normal format can be used across all three resolutions. The
following file extensions are used:

PI1  Low Resolution
PI2  Medium Resolution
PI3  High Resolution

The following file format is used:

1 WORD Resolution flag (0, 1, 2 for PI1, PI2, PI3).

16 WORDS Hardware Colour Palette.

32000 BYTES Picture Image Data.

4 WORDS Only the first WORD is used by HyperPaint.
Left cycling limit (0-15).

4 WORDS Only the first WORD is used by HyperPaint.
Right cycling limit (0-15).

4 WORDS Only the first WORD is used by HyperPaint.
Cycling Direction. O = Left , non-zero = RIGHT.

4 WORDS Only the first WORD is used by HyperPaint.
Cycling Delay. Permissible values: 0-128, indicating the
number of 20 ms periods between colour shifts.
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DEGAS COMPRESSED FILE FORMAT

The DEGAS Compressed format can be used across all three resolutions. The
following file extensions are used:

PC1 Low Resolution
PC2 Medium Resolution
PC3 High Resolution
The following file format is used:
1 WORD Resolution flag (0, 1, 2 with bit 15 set for PC1, PC2, PC3).
16 WORDS Hardware Colour Palette.
IMAGE DATA Compressed as described below.

4 WORDS Only the first WORD is used by HyperPaint.
Left cycling limit (0-15).

4 WORDS Only the first WORD is used by HyperPaint.
Right cycling limit (0-15).

4 WORDS Only the first WORD is used by HyperPaint.
Cycling Direction. 0 = Left , non-zero = RIGHT.

4 WORDS Only the first WORD is used by HyperPaint.
Cycling Delay. Permissible values: 0-128, indicating the
number of 20 ms periods between n colour shifts.

The compression algorithm is based on BYTE opcodes whose meaning is as
follows:

BYTE OPCODE n ACTION

0..127 Copy the next n+1 bytes literally.
-1..-127 Copy the next byte (-n + 1) times.
-128 Do nothing.

Bit planes are compressed separately (i.e. in STANDARD form) on a scan line by
scan line basis).
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DRI BIT IMAGE FILE FORMAT

A GEM VDI bit image file contains information that can be used to re-create a
picture from'its bit (pixel) image. The file consists of a header and raw pixel
information. The pixel information can be encoded in a variety of formats.

A bit image file has an extension of IMG.

Bit Image File Header

The bit image file header consists of (normally) eight WORDS in 68000 format
(High byte precedes Low byte):

Word Contents

IMG file version number

Header length in WORDS (normally 8)
Number of planes (1, 2 or 4)

Pattern length in bytes (normally 2)
Source device pixel width in microns
Source device pixel height in microns
Scan line width in pixels

Number of scan lines (height in pixels)

NonbhL—O

WORD 1 indicates how long the header is. HyperPaint optionally extends the IMG
header by an additional 17 Words to accomodate Hardware Palette Information as
follows:

Word Contents
8 0x0080 HyperPaint 'Valid Palette Flag’
9-24 16 Words Hardware Colour Palette.

The header length (WORD 1) is then extended to 25.
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Bit Image File Data Format

A bit image file is composed of a series of scanline items each one of which
consists of

A vertical replication count
Encode data for each plane.

The vertical replication count is coded as 4 bytes:

Byte Contents

0 NUL

1 NUL

2 FF Hex

3 Replication Count ( less than 256)

The encoded data for each color plane follows the vertical replication count. The
planes are assumed to be in Standard (rather than Device-specific) form. Data is
always provided for all defined bit planes. '

Note: the number of pixels described for each bit plane of a scan line is not
necessarily the scan line width specified in the file header. Because the data is
encoded in byte-wide packets (groups of eight pixels), the number of pixels
actually described is always a multiple of eight and is never more than seven
pixels wider than the scan line width.

Plane data is encoded in one of three modes:

SOLID RUN, PATTERN RUN, or BIT STRING.

A SOLID_RUN item contains a single byte that describes a state and the number
of bytes for which that state is true. The high-order bit defines the state where:

1 = pixels ON
0 = pixels OFF

The low-order seven bits define the run length (1 to 127).
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A PATTERN_RUN item describes a set of pattern bytes and the number of times
the pattern bytes should be repeated. The number of bytes in a pattern is defined in

the bit image file header; typically, it is two for a screen device image. Itis
defined as follows:

Byte Contents

0 NUL

1 Length of run

2 First byte of pattern

= -

Last byte of pattern (n is defined by header word 3).

A BIT_STRING is used to encode streams of pixels which cannot be encoded
efficiently as solid runs or pattern runs:

Byte Contents

0 80 Hex

1 Byte count (1 to 255)
2 First byte of bit string

= -

Last byte of bit string.




APPENDIX E

CUSTOMER SERVICE INFORMATION

Atari Corporation welcomes questions about your Atari computer products. Write
to Customer Relations at the address below.

Atari user groups are outstanding sources of information on how to get the most
from your Atari product. To receive a list of Atari user groups in your area, send a
self-addressed, stamped envelope to User Group List at the address below.

In the United Kingdom, write to:
Atari Corp.(UK) Ltd.

P.O. Box 555

Slough, Berkshire

SL2 5BZ

In the United States, write to:
Atari Corporation

P.O. Box 61657

Sunnyvale, CA 94088

Please write the subject of your letter on the outside of the envelope.
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